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Section 1 - Product Overview

System Requirements

To ensure your D-ViewCam system can maintain high video monitoring and recording performance, certain minimum
system configurations are required.

CPU Intel Core 2 Duo E5300
RAM 2 GB
Motherboard Intel P55, H55, X58, P45, P43 chip, MB vendor ASUS
Gigabyte or MSI with Intel Chipset recommended
Display card ATI Radeon 4650 or above (ATI Driver V11-2 recommended,)
Ethernet 100Base-T or above, Gigabit LAN recommended
Hard Disk 250 GB or above
0s 32 bits: MS Windows XP pro SP3/Vista SP1/Win 7 SP1/Win 8
64 bits: Win 7 SP1/Win Server 2008 R2/Win 8/Win Server 2012

Note: To determine the minimum hardware requirements for your planned surveillance system if it is not listed in the
above table, please consult the SlI (system integrator), the reseller, or D-Link Technical Support.

Note: Recording video over a long period of time will consume large amounts of disk space. Make sure that you have
enough disk space available if you want to use the recording function. You can still complete the installation even if
you have less than the suggested free disk space.
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Section 1 - Product Overview

Introduction

Thank you for purchasing a D-Link IP camera, which provides state-of-the-art camera technology combined with IP
network capabilities. You can build a home or small business surveillance system by using D-Link IP cameras and the
latest features offered by the D-ViewCam application software.

Features

D-ViewCam can automatically locate and add IP cameras in the local network.

Storage management for recording files.

Single and multiple video stream monitoring (up to 32 video channels).

e Two-way audio communication.

Intelligent filter and search capabilities for scheduling recording and/or event recording.
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Section 1 - Product Overview

Installing Your IP Camera

Before installing D-ViewCam, please make sure you have installed your D-Link IP camera(s) that will be managed by
D-ViewCam.

Step 1 - Follow the installation procedures that came with your IP camera(s) to complete the camera
installation process.

Step 2 - Verify that you are able to view the video images from the IP camera(s) by accessing the camera’s
web-based configuration utility. It is recommended that all IP cameras be installed in the same
subnet as your management PC running the D-ViewCam software.

Step 3 - Please refer to the Add Camera step in the next section Software Installation to add IP camera(s)
to the D-ViewCam system.

Note: D-ViewCam is optimized for a small-scale LAN environment. To protect the system and cameras from attacks from
the Internet, install the D-ViewCam software on a computer that is protected behind a firewall or an IP sharing device.
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Section 2 - Installation

Software Installation

Turn on the computer and insert the D-ViewCam CD into the CD-ROM drive. Below step-by-step instructions will be
shown if you are using Windows® XP. However, similar instructions and screens will also be provided for other Windows

operating systems. When the autorun screen starts, click Install D-ViewCam.

Note: If the Installation Wizard does not start automatically, you can manually start the wizard by double-clicking the

setup.exe file from the CD.

1. Select a language and click Next to continue.

2. Click Next to continue.

D-Link D-¥iewCam - InstallShield Wizard =]
Choosze Setup Language
Select the language for the installation from the choices below.
Chinesze [Simplified] ¥
Chinese [Traditional] =

D anish

Erglish

French [Standard)

Geman

Greek
Italian

Japanese ‘

m

Forean

Portuguese [Brazilian)

Portuguese [Standard) | &
Russian

nnnnn

< Back | Mext » I Cancel |

D-Link D-¥iewCam - InstallShield Wizard x|

‘Welcome to the InstallShield Wizard for D-Link
D-YiewCam

The InstallShield Wizard will install D-Link. D-iewCam on
your computer. Ta continue, click Mext

Cancel |
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Section 2 - Installation

3. Click I accept the terms of the license agreement
radio button and then click Next to continue.

4. Enter your name and company name. Click Next to
continue.

D-Link D-¥iewCam - InstallShield Wizard

License Agreement
Pleaze raad the following license agreement carefully,

LICEMZE STATEMENT

Al title and copyrights in and to the SOFTWARE PRCODUCT are ovwned by D-Link
Corporation, itz affiliates, or suppliers (collectively D-Link), and are protected by
domestic and international intellectual property lavws and international tresties, The
SOFTYWARE PRODUCT is non-exclusively licensed and not sold. % ou (Client)
acknowledye and respect any and all intellectual property rights of D-Link, including all
software, facilities, patert rights, trademark rights, copyrights, specific technalocgy and
business secret of the product and service provided. Any form of behavior damaging
the intellectual property rights of D-Link is strictly forbidden. Client shall not reverse
engineet in any form of the above mentioned software, equipment and item, or modify,

ol mmrl s wemt g Al il e ol i Lol bl o m et e bl T i el v e

& accept the terms of the license agreement Print |

" | da nat accept the terms of the license agreement

InstalShield

[

¢ Back | Mest » I Cancel |

D-Link D-¥iewCam - InstallShield Wizard

Cugtomer Information

Pleasze enter pour infarmation.

Please enter your name atd the name of the compaty far which you wark.

Usger Mame:

Imy narne

LCormpatiy Mame:

Im_l,J compary

IrztallShield

¢ Back | Mest » I Cancel
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Section 2 - Installation

5. Select Complete to install the entire D-ViewCam software
package or select Custom to choose which programs to
install. Click Next to continue.

6. Click Install to continue. The installation process may
take a few minutes.

D-Link D-¥iewCam - InstallShield Wizard

Setup Type
Select the setup type to install

Please select a setup type.

All program featuras will be installed. [Requires the most dizk space.]

Select which program features pou want installed. Becommended for
advanced users.

InstalShield

¢ Back | Mest » I Cancel

D-Link D-YiewCam - Installshield Wizard x|

Ready to Install the Program
The wizard iz ready to begin installation.

Click. Install to begin the inztallation.

I yo want ko review or change any of vour installation settings, click Back. Click Cancel o exit
the: wizard.

ImztallShield

<Back |{ nsfal Y Cancel
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Section 2 - Installation

7.You may be prompted to install Visual C++ Runtime
Libraries. Click Yes to install.

8. Click Yes to accept the license agreement.

9. Click Finish to complete the installation process.

Question =

2

Wisual C++ 2005 Runtime Libraries is the necessary component to run this produck,
would you like ko install now? {recommended)

Microsoft Yisual C++ 2005 SP1 Redistributahbl =00 x|

TR Y T

E|Micr050ft Misual C+4 2005 SP1 Redistrib

Fleaze read the following license a
to zee the rest of the agreement.

MICROSOFT WISUAL C++ 2005 RUNTIME LIBRARIES

These licenze terms are an agreement between Microzoft Corporation
[or bazed on where pou live, one of itz affiiates] and you, Pleaze read
them. They apply to the software named above, which includes the
media on which you recered it if any. The terms alzo apply to any
Microzaft

* updates,

* supplements,

* |nternet-bazed ervices, and

* support services

for this software, unless other terms accompany thoze tems. IF 2o,
thoze terms apply.

By uzing the software, you accept these terme. [ pow do not accept ;I

MICROSOFT SOFTWARE LICEMSE TERMS j

Do you accept all of the terms of the preceding Licenze Agreement? [F pou
chooze Mo, [nstall will cloze. Ta install you must accept this agreement.

Ve Ma |

D-Link D-YiewCam - InstallShield Wizard

InstallShield Wizard Complete

The InzstallShield \Wizard has successfully installed D-Link
D-iewCam. Click Finish to esit the wizard.

< Back

Lance! |
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Section 2 - Installation

10. To start D-ViewCam, select Start > All Programs > D-Link
D-ViewCam > Main Console.

B D-Link D-ViewCam EI Backup Sstem

4 Windows Search kJd DBETook

i Main Console
Flayback System
Eemote Live Viewer
2 Uninstall D-ViewCam
[4] Verification Tool

11. The first time you launch the Main Console, you will need to
create the admin password. Enter the password and then I 7o s
enter it again to confirm. Click OK to continue. ' L Ssae g

D-Link

Building Metwearks for People

First Execution of Main Console System |

Please enter passwoard for administrator

Lser Account: Iadmin
Fasswaord: ||
Password Confirm: I

v 0K ‘ X Cancel |
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Section 2 - Installation

Add Camera(s)

12. Once the console loads, click on the General
Setting |8 icon, click Setting, and then click
System Setting.

13. Click on the Camera tab.

Note: If your IP cameras support UPnP, follow step 14.
Otherwise, skip to step 16.

14. Click Search to automatically find the IP camera(s) that are
on your local area network (LAN).

&S

ething

neral Camera \uo Device | PTZ Canfig | Hotline | Address Baok | Manitor Display |

#ySeorh [luwt PDelete | 4 Conti

M & camot D-Link DCS-6510 (192, 168.2.49

[CAM1 D-Link DCS-6510 (192.168.2.49)

;
=
=
2
B
=

[

I A
N 5
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Section 2 - Installation

15. Select one of the IP cameras that are available. You may enter
a new name for this camera and then enter the username
and password assigned to this camera. Click OK to add the

camera.

Note: The default username is admin and the default

password is blank.

16. If your camera(s) do not support UPnP or your camera(s)
were not found, you can manually add a camera.

Click Insert to manually add IP Camera(s) that are on your

local area network (LAN).

Search IP Cameras

IP Camera Search Completed

[ Start Scan

P Wendor Mode!
[m}192.165.0.64 D-Link
Oi192.168.2.213 D-Lirk

IP Camera Option

MAC

Camera Marme: |D-Link DCS-5230 (192.168.0.64)
User Name: |adrmin

Password: |

[/ (o174 ] Ix Cancel ]

x|
Ganeral Camera | yo Device | PTZ Canfiy | Hotine | Adoress Book | Maniar Dispiay |
#5 Search & Delete \ “ Config
nsert & new IP camera.
Carnera Pararneter G50 Setling

¥ Enzble
¥ Dste 2008111111 2
I Tirme AM09:52:00 2

Garmera Setfings I# Camera Mumber

Yiten Parareter J=| Carmera harme Font
¥ Bitrate Anply Al

X Cancel
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Section 2 - Installation

17. Enter the following Network information for your camera:

* Name - Enter a name for your camera.

e |P Address - Enter the IP address of the camera.
If you want to use a domain name, then check the
DNS box and enter the domain name of the camera.

HTTP Port - 80 is the default port.

User Name - Enter the user name for the camera.
Password - Enter the password for the camera.
Protocol - Select TCP, UDP, or HTTP.

Enter the following Device information for your camera:

e Auto Detect - Click the Auto Detect button to detect
the vender and model information.

* Vendor - Select the brand name/vendor from the
drop-down menu.

e Camera Model - Select the camera model from the
drop-down menu.

* Video Channel - Select the video channel you want
to assign the camera to.

18. Click OK to add your camera.

IP Camera f ¥ideo Server Sething

Metnwiark

Mame:

IP Address:
Hitp Port:
User Mame:
Fasgwoard:
Frotocol:
Device

Yendaor:

Carmera Model:

YWideo Channel:

Description

Yideno Codec.MPEG4
Aldio Codec: G711
Camera:l, DL2, Do

]

|Depar‘[ment
192 0168 . 0 . 70 T DNS
EX
|au:|min
|7.-:.-.0.-:.-x
o - & HTTP
D-Link | [ Auto Detect
DCS-3710 =
M1 2 e
B r B B
MIPEG

[\/ Ok ] [x Cancel]
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Section 3 - Configuration

D-ViewCam Interface Overview

This section will show you how to start and configure D-ViewCam.

El Backuop Systemn
kd DBTook
it Wadn Consals

Flayback Svstem
Eemote Live Viewer
2 Uninstall D-ViewCam
[4] Verification Tool

B D-Link D-ViewCam

To start D-ViewCam, select Start > All Programs > D-Link
}} Windows Search

D-ViewCam > Main Console.

Enter Admin as the default username and enter your password.
Click OK to log into the system.

D-Link

Building Metwarks for People

Please enter user name and password

User Mame: Iadmin

Password: I

« 0K | X Cancel|
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Section 3 - Configuration

Main Console

®_

@_

1 |Main Display Area

2 |Log Out/Exit Program

3 [Minimize Window

C

¢

R =N -

é)%)@éb

Monitor

Playback

Configure Schedule

Configure Smart Guard
System
General Setting

System Information

BEI

6

.| DT

) o A

é

®

10

Split-Screen Options

11

PTZ Features
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Section 3 - Configuration

Log Out/Exit Program/Minimize Window

@ Click to log the current user out or to close the D-ViewCam program.

w Click to minimize the window.

Split-Screen Options

Select a split-screen display layout by clicking on the desired layout icon. The system provides 4, 6, 9, 10, 16, and 36 split-screen modes.
To switch to single camera display, double-click the camera’s image. To return to the previous configuration screen, press the Esc key or
double-click on the screen again.

=

™ Displays 1 screen. ™ Divides into 9 screens.  [TEEM Divides into 32 screens.

g =

i F
- ¥ Divides into 4 screens. Divides into 10 screens. Lf/ Switch to full screen.

&1 Divides into 6 screens.
1

Divides into 16 screens. ,EIE Rotate all screens.

D-Link D-ViewCam User Manual 18



Section 3 - Configuration

Monitor

Start Maonitar &ll
Skart Recording Schedule
Skart Smark Guard System

Open Event Repart
Open E-Map
Cpen I/ Conktrol Panel

Lock, System

Option Function

Start/Stop Monitor All Click to start or stop all monitoring functions.

Start/Stop Recording Schedule |[Click to start or stop the recording schedule.

Start/Stop Smart Guard System [Click to start or stop the smart guard system.

Open Event Report Click to open the event report which will log any events.
Open E-Map .C|I(.Jk to open E-Map which monitors all devices with map
indicators.

Click to open the I/0O control panel which montors the DI/DO

Open I/O Control Panel and manual triggering the DO devices.

Lock System Click to lock the system.
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Section 3 - Configuration

Monitor:
Click on the Start Monitor icon and select from the menu to start/stop recording schedule system or the guard system features.
You can also open monitor tools such as event report, E-Map, 1/O control panel, and system lock.

Playback:

Click on the icon to open the Playback Console. You can watch recorded video, search recorded video, adjust the image of
the stored data, save video/pictures, print images, check log information and event records, and set up recording function
configuration. See the PlayBack section for details.

Schedule:
Organize the recording time schedule and configure recorder settings. See the Schedule section for details.

Guard:
Add/edit type(s) of events that you want to detect and setup action(s) responding to events. See the Guard section for details.

General Setting:
Select to modify general settings, user account settings, save/ load configuration settings, access log viewer and backup files,
and configure network services. See the Config section for details.
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Section 3 - Configuration

System Information
Displays the date, time, free disk space, IP Camera bitrate, customized text, and network utilization.

PTZ Features

PTZ Control
Control the movement of PTZ (pan/tilt/zoom) cameras. With cameras that support PTZ control, you can move, zoom,
patrol, auto pan, adjust focus, and set preset points. Click on the Home icon in the center to return to the original view.

Zoom
Click on the + sign (Zoom Tele) to zoom in or click the — sign (Zoom Wide) to zoom out.

Add Preset Point/Go to Preset Point

Adjust the camera view until you are satisfied. Click on the Set icon and set up the view as the preset point 01. Adjust the
camera view again and set up the preset point 02. Repeat the process until all preset points are set. You can assign a
custom name to each preset. Click on the Go icon and view the result of your setting.

Note: To adjust the speed settings of the PTZ camera, go to General Setting > Setting > System Setting > PTZ Config.
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Section 3 - Configuration

Patrol

Go to Add Preset Point > Set Patrol to bring up the Patrol Setup dialog. From the left window, select the camera(s) that
you would like to have in the patrol group. Align the cameras in order in the right window and adjust the time. Rename the
group name if you want. After completing the setup, check the Active option, and then click OK.

Patrol Setup &
Group 1 lGruup 2 I Graup 3} Group 4 I

[@Freser
G Presetz Group Narme : ’W

@Presetl3

Period: §sec

[ Active

(=]

[/ oK ] [)( Cancell

You can set up up to four groups of auto patrol. To start or stop, click on the Go to Preset Point icon in the Main Console,
and select Start Patrol or Stop Patrol.

Auto Pan
Go to Go to Preset Point and click on Start AutoPan to enable auto pan. Click on Stop AutoPan to stop.
Auto Pan enables the camera to scan an area horizontally from left to right or right to left.

Focus

You can select to focus the camera near, far, or have it auto focus. Click on the + sign to focus near, click on the - sign to
focus far, and click on the center icon to auto focus. To focus near means objects that are closer will be clearer than

the objects that are further away. In contrast, to focus far means objects that are further will be clearer than the objects that
are closer. Click on the Focus icon and select auto focus if you want the system to decide the focus point for you.
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Section 3 - Configuration

On Screen Menu
Right-click on the camera screen and get the “On Screen” menu, from which you can quickly adjust the settings of your camera.

Enable Move
With cameras that support PT function, click Enable Move to adjust the current camera’s view by clicking on the display screen. To cancel
this function, right-click on the screen and select Disable Move.

Enable Talk
With cameras that support two-way audio, select Enable Talk to utilize the function.

Connect/ Disconnect
Right-click on the display screen and select Connect/Disconnect to modify the connecting status of the camera.

Show Camera
Select the camera from the Show Camera menu to display video on selected screen. The list of cameras will be displayed in the right
column of the monitor display panel.

Delete Camera
Click on Delete Camera to remove a camera from the display screen.
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Section 3 - Configuration

Enable Digital PTZ
To enable the PTZ functions of the camera, select the Enable Digital PTZ option. Use the mouse wheel or click on the + and — signs to
zoom in and zoom out on the camera. The square flashing on the video grid indicates the correspondent view of the camera.

Fix Aspect Ratio
Enable Fix Aspect Ratio to view the original ratio video or disable this option to stretch 3:4 to fit window.

Snapshot

Select the snapshot function to capture a screen shot of the current video. You have the option to copy the image to clipboard or to save
it. You may select the OSD option to export the image with date/time and camera number/name text. If the digital PTZ function is enabled,
you can decide either Full size or Selected region as your snapshot region.

Manual Record
Select to start recording video.

Toggle Fullscreen
Select it to view live video(s) in fullscreen. Press ESC to go back to original window.

Live Display
Live display is flexible to change channels and screen divisions. Each screen division will have the same display list, but have the different
sequence. Such like, when using Show/ Delete Camera function to edit camera list, the operator will apply to all different screen divisions.

Duplicate Camera
To duplicate the feed from a camera, right-click on a blank area of the screen and select Duplicate Camera. Select the appropriate camera
to duplicate the feed from. The duplicate view from the camera will then be displayed adjacent to the original view.
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Section 3 - Configuration

Configuration

Click on the General Setting ﬂ icon. Click Setting to configure your settings.

Ead License Manager

Save/Load Configuration 2
B Log Viewer
B Backup

Metwork Service

About Main Console...

D-Link D-ViewCam User Manual
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Section 3 - Configuration

General

Startup

Main Console: Check to open the Main Console system
when windows start up.

Check the following 3 main functions and 2 network services
to auto-activate functions when the Main Console system
is starting, including Schedule Recording System, Smart
Guard System, Live Streaming Server, and Remote
Playback Server.

Full Screen: Check to launch video at full screen when
launched.

Setup Auto login: Enable “Auto login” and click the Setup
button to open the Auto Login Setup panel. Enter the User
Account and Password to login automatically when the
system starts. Enable Minimize after login to minimize the
Main Console window after login.

General I Camera] 1/0 Device ] PTZ Config } Hotline } Address Eluukl MunilurDispIay]

Startup

v Main Console

I Schedule Recording System
™ Smart Guard System

[ Live Streaming Server

" Remote Playback Semver

I™ Full Screen

I~ Auto Lock System

[~ Auto Login

Setup

Wiscellaneous
[~ Automatically popup event report

I~ Minimize to system tray
r
™ Synchronize video frames

Storage

Location E]

C:\Program Files\D-Link\D-ViewCam

Automatic Recycle:

* Recycle when disk space is

less than 10 %
i Only keep video for 7 days
Log Recycling ]

Audio Preview

Default Channel (NotUsed) -

I Enable Audio on Active Channel

Volume Ji

e .

Status Display

[¥ Current Date

[¥ Current Time

¥ Login User

¥ Free Disk Space
[~ IP Camera Bitrate
[~ UserDefined Text 1

—

[T User Defined Text 2

—

Auto Reboot

I Enable Auto Reboot
Every |Day
at (01:00 AW

‘\/ OK ‘ I)( Cancel]

Auto Login Setup

User Account:
Password:
Password Confirm:

[~ Minimize after login

[J OK ] [x Cancel]

D-Link D-ViewCam User Manual
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Section 3 - Configuration

Storage

Location:
Assign the default folder for the system to store data files. It is recommend that you don’t save in the
system drive (C:\) to avoid a drop in your PC’s performance when free storage is low.

New Click to add a new location. Click the ... button to browse to a folder.
Click OK to save the location.
Delete Highlight a location and then click the Delete button to remove it.

Highlight a location and click the Move Item Up button to move the

Move ltem Up |, ation higher in the list.

Highlight a location and click the Move Item Down button to move

Move ltem Down the location lower in the list.

¢ =) & (E]

Automatic Recycle: The system will automatically delete out-of-date data to save storage space.

* Recycle when disk space is less than: Select and enter the available space (in percentage). When
the default folder available space falls below the entered about, the system will begin to store data
to the next folder in the location list. If all the status of locations exceeds the storage rule, the system
will start recycling in an hour progress.

* Only keep video for: Delete the video records that are older than the number of days set. If the
default storage spaces exhausted (disc space is less than 1200 MB), the system will start to recycle
by hourly period.

* Log Recycling: Click to set the days that you want to keep specific event logs or keep all event
logs within interval of video files.

1. Event Log: Delete the event log data that is older than the number of days set.

2. System Log: Delete the system log data that is older than the number of days set.

3. Export and Backup Log: Select whether to export and back up the log permanently, within
the video interval, or for a number of days.

Storage

Location E]

C:\Program Files\D-Link\D-ViewCam

Automatic Recycle:

{« Recycle when disk space is

less than 10 %o

(" Only keep video for T days

EventLog

" Keep event log within interval of video files

&+ Keep event log for 7 days

System Log

" Keep system log within interval of video files

&+ Keep system log for 14 days

Export and Backup Log

" Keep export and backup log within interval of video files

+ Keep export and backup log for 14 days

" Keep export and backup log forever
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Status Display

Select the information that you wish to display in the information window on the Main Console such as Current Date, Current Time, Free
Disk Space, IP Camera Bitrate, and User Defined Text.

"¢ Status Display
’ 201103701 [# Current Date

12:06:59 ¥ Current Time
acimin ¥ Login User
Iv Free Disk Space

[ IP Camera Bitrate

= ﬁ = [~ User Defined Text 1
- [ ——
ﬂ | | ‘ [~ UserDefined Text 2
—
_e ' Start Live ¢— Start Remote
Streaming Playback service

service
Miscellaneous

Automatically Popup Event Report: Make sure to stop Smart Guard System before you modify this setting, otherwise the modification
will not take place. The Event Report dialog box will automatically popup when events have been detected.

Minimize to system tray: Enable this option to display an icon in the task bar when clicking the minimize button.

Note: Enter the username and password of Main Console again when clicking the minimized Main Console icon in notification area of
windows task bar to start monitoring.

Synchronize video frames: Select to prevent tearing that may occur in the video display. However, this will increase the CPU processing
load.
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Audio Preview
Default Channel: Select the audio channel that you wish to hear from.

Enable Audio on Active Channel: Select the Enable Audio on Active Channel option to hear the audio from the selected video channel
on each video grid of the Main Console. The default channel plays if the video channel isn’t selected.

Volume: Adjust the volume with the “volume bar.”

o
N 5
. JIEY

o
o_0
oo
000
[ & [+]-]

552050 BEZDS
9. B e :

System plays the audio of “default channel” System plays the audio of left-top “selected
channel”
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Camera

Add Camera
Four function buttons will be included in the Setting/Camera
panel.

Search: Click on the Search icon to obtain the Search IP
Camera panel. The system will start scanning automatically
once the panel is opened. You may manually stop scanning
by clicking on the Stop Scan button.

Fill in the user name and password for each |IP camera found
and click OK to add it to the camera list.

Note: Drag the mouse to multi-select the cameras and
then insert the username and password. The username
and password will be applied to all the selected cameras
automatically.

ik Seiting

General Camera | 0 Device | PTZ Conig | Hotiine | Address Book | Monitar Disalay |

fyseanh flnert PqDelte | 4 Config

&5 CAMO1 Department

& CaMD2 D-Link DCS-6100 (192,166
& CaMD3 D-Link DCS-1100 (192,166
& CaMD4 D-Link DCS-6620G (102, 1¢
& CaMDS D-Link DCS-5230 (192,166

|~

1%

CAMSD-LinkDES-5230°(1920168.0.64)

—Gamera Parameter
ID-Link DCS-5230(192.168.0.64

[ Go toeh Interface ]

[ Camera Seftings |

[ Yideo Parameter ]

~ 05D Setting

[+ Enable
[~ Date
[~ Time

[~ Bitrate

¥ Camera Mumber

¥ Carmera Mame

I2009J‘1 208 VI
IPMD?:E?:DD VI

I 0K | [x Cancel ]

D-Link D-ViewCam User Manual

30



Section 3 - Configuration

Insert: Click to open the IP Camera/Video Server Setting panel and add IP cameras to the list.
Delete: Click to remove the selected IP camera(s) from the system. Click OK to finalize the modification.

Config: Click to obtain the IP Camera/Video Server Setting panel. You can modify the IP camera settings with the Setting panel.

IP Camera / Video Server Setting Panel

Network: Fill up the Network field (including Name, IP Address, Http Port, User Name, Password and Protocol) referring to the instruction
provided by the camera manufacturer. Check “Use DNS” to use domain name instead of IP address.

Device: Choose the IP camera manufacturer from the drop-down menu. Click on Auto Detect and the model name will show in the box.

Description: Displays information about the device.

IP Camera [ Yideo Server Setting E|
Metwork
Marme: |Depar‘[mem
IP Address: | 192 166 . 0 . 70 I DNS
Http Part: |80
User MName: |admin
Passwaord: |“"""‘*
Praotacol: o r & HTTE

Device

Yendar: |D—Link j Auto Detect
Camera Model: DCS-3710 -

Widea Channel: W1 T ™ r
I~ r r r

Description

Video CodecMPEGS MIPEG
Audio Codec:GT11
Camera:1, Dl2, DO

I/ oK ] [x Cancel]
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Camera Parameter

General Camera | 10 Device | PTZ Config | Hotiine | Address Book | Monitor Display |
i Search i Inset i Delete | 4 Corfig (GAMIED Lk DES-60101 (192:16810:104)]
[ &5 CAMOL D-Link DCS-6010L (192.168.0.1

~Setting———————————————— | Miscellaneous |
ID—Lmk DCS-6010L (192.168.0.° [v Enable
[ Date 2012/10/19 -
Go to Web Interface [ oz PI04:03:00 - |
[¥ Camera Number
Camera Settings
¥ Camera Name
Video Parameter
[~ Bitrate
[ Font ] [ Apply All I l
] i v

v OK | [x Cancel]

Camera List: Displays all the cameras that are connected to the system. Click the name of the camera to edit the settings.
Camera Name: Name the camera for your convenience.

Go to Web Interface: Go to the web-based interface of your camera to configure the settings (optional).

Camera Settings: Edit the camera’s parameters offered by camera vendor. Refer to the next page for more detailed information.

Video Parameter: Adjust the video’s brightness, contrast, saturation, and color hue values.
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Camera Settings

Camera Settings u
—Image Quality
Video Format: " MJPEG © MPEG4 & H264
Frame rate: =
Resolution: |1200x900 j
Bitrate Mode: IFixed quality j
Bitrate: I M j
Cluality: | Excellent
Stream ID: I j
—Image Adjustment
[~ Enable Flip

[+ Enable Mirrar

—Audio
[+ Enable Microphone
[+ Enable Speaker

—Fish eye setting
Mount Type IDesktop j

Display mode |2Fl j

v  OK | X Cancel|

Video Format: Select the video format for the footage.
Frame Rate: Select the frame per second.
Resolution: Select the resolution.

Bitrate Mode: Select the bitrate mode.

Bitrate: Select the bitrate amount.
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Image Adjustment: Enable image to be flipped or mirrorred.

Audio: Enable microphone or speaker if your camera has these features.

Fish eye Setting (for fish eye cameras only)
Mount Type: Select whether the camera is being mounted on a wall, ceiling, or on a desktop.
Display Mode: Select the display mode from 10 (fisheye mode shows the full camera view), 1R (normal mode shows a view similar to a

standard camera), 2P (panoramic mode shows a full 180-degree mode across 2 panels), 10 3R (multi-view with Fisheye mode shows a
multiple window view with fisheye in the top-left panel), and 4R (multi-view).
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OSD (On-Screen Display) Settings

Select the information that you wish to see on the on-screen display. Click the Font button to select the font style.

Choose Font
— Foreground
Font: ITI Tahorma j
size: o <
Colar: |:| M
| Bold |« Edoge
—Background
Color: I M
Transparency: 210

[ ok |[ canl

l
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I/0 Device

a Setting &_
General I Camera O Device 1 PTZ Config } Hotline } Address Buuk] MumturDlsplayl

110 Dewice Sefting Digital inputioutput pins of selected 'O module

O —— —
Module: D-Link DCS-RR20G (192 Name Input 0 Type: MNIC ha

Modify
Device ’—_| " "
Fin MNarne: Signal Type
comport  [comio <] Hoin  Irputo Mo
DOD  Output O [Nlis]

i T—

Maodule Device D
E Depart... 1P Camera
E O-Link D... IP Camera

E D-Link D... 1P Camera

Digital Input Manitor Digital Output Simulation

(@] Q

0 i

7o ] (X carea |

I/O Device Setting:
* Module: Name of the module and ID of the digital input/output device(s) that is connected to your system.
* Device: This column displays the device(s) already installed to the system.
* ID: Select the I/0O port.

Input Monitor: The device(s) is turned on if the dot is in red. By triggering the digital input device, the related icon will light up. This is
used to check if the device is correctly connected or not.

Output Monitor: The device(s) is turned on if the dot is in red. By clicking on the icon, you may trigger the digital device connecting to the
system. This can be used to test if the output device is correctly connected.

Device Setting
Name: Insert the name of the device (input and output).
Type: Select the device type from the drop-down menu.
1. N/O: Normal Open.
2. N/C: Normal Close.
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PTZ Config

i Setting

General I Camera ] 110 Device  PTZ Config l Hotline } USerAccuunl] Address BUUK] MuniturDispIay] Juystick]

O & camol Camera 1
O & camoz Camera 2
O & camoza Camera 2
F:4Cam04 Camera 4

Basic Setting

Camera Model: |Pe|c0 n] j
Com Port: m
Baud Rate 2400 hd
Address: W

Advanced Setting
Pan Speed: —)— Medium
Tilt Speed: 7)7 Medium
Zoom Speed: 7)7 Medium
i
Wiscellaneous
Patrol Group ] ’ User-Define Preset ]

X

[/ oK ] [X Cancel]

Check the box on the camera list to activate the PTZ control function of a PTZ camera.

Basic Setting: Select the camera model, com port, baud rate, and address of your PTZ camera.

Note: If your camera model is an IP camera, the PTZ function will work directly without the com port, baud rate, and address settings.

Advanced Setting: You may set up the pan speed, tilt speed, and zoom speed. Adjust the settings by dragging the bars.

Miscellaneous:

Patrol Group: You can set up a Patrol Group.
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User-Define Preset: User-Define Preset can trigger the extra-function of speed dome itself such as auto-tracking, login menu of camera...
etc. You can refer the detail description of each speed dome on it’s user manual.

Step 1: Type a Preset Name. User-Defined Preset Dialog x|

Configuration

Step 2: Type the Preset Number.

FPreset Mame: |fun|:1ic|n 4

Step 3: Click OK to save your preset. Preset Number: |70
You may click Add to add a new preset, highlight [ oeme | [ Oeia
a preset in the list and click Delete to remove it, or = A
highlight a preset and change the preset name and/or D | Mamne Preset
preset number and then click Update to save. 1 pont 17 50

2 function 1 99

3 function 2 95

4 function 3 63

5 function 4 70
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Hotline

X

4k Setting

General} Camera] lls] Dewce] PTZ Config  Hotline Mddress Eluuk] MonitorD\splav]
E-Mail
*SMTP Senver: *Part. |25

*E-Mail Sender; |

E-Mail Subject |

Body Content

[~ SMTF server needs authentication r
| Send Test Mall

IJ oK ] [X Cancel ]

Configure the Hotline settings including E-mail, once an unusual event is detected.

E-mail: Input the following information: Server, Port, Sender's E-mail address, E-mail’s subject title, Body content and SSL option for
encrypted transmission. Click on the Send Test Mail button to test the settings.
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Address Book

Address Book: Manage the address book from which you may send out an E-mail when an unusual event is detected.

@ Setting

General| Camera' 110 Device | PTZ Conﬁg' Hotline| User Account  Address Book I Monitor Display

Please inputthe name and contact information

Name: IMichaeI Phone: |555-1123125 E-Mail: Imike@hotline.com

Description: I

[ Add || clear || Wodiy

{ ’ Remaove

Contact persons

MName Phone E-Mail Description
B Michael 555-1123125 mike@hotline.com

(v

OK l ’x Cancel]
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Monitor Display

4&- Sething [z

General | Gamera | U0 Device | PTZ Config | Hotiine | Address Boak ~ Monitor Display |

Run Flayhack on Monitor

m Primary l

! E
g0l DCS-3710 F01 DCS-3710_1 Auto Scan
1§02 DCS-5300G ‘@0z DCS-5300G_1 Primary Channel 01 DCS-371 -
Secondary Channel |0z DCs-530 - |
Auta-scan Interval 2 sec.
Layout
o ) | x

[« Ok | ’)( Cancel ]

Cameras List: The left column displays a list of all available cameras. Highlight the camera and click the right arrow --> to move the
camera to the right column. The right column will display the primary and secondary cameras. These cameras will be available for the
auto-scan function.

Auto Scan: Activate auto scan to rotate the channels / cameras on the display screen.
For instance, you may select to show only 4 sub-screens on the Main Console while having 16 channels connected to the system. With

auto scan function, you will be able to see all 16 channels by turns. You can set up a primary channel that will always be on the screen
and a secondary channel that has secondary priority.
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User Account Setting

Only the default admin account can manage user accounts. From the list on this tab, highlight each account and modify the privilege setting.

Note: When entering into this page, the system will display one of the account group’s default privilege profiles first. End users can insert

Name and Password to create a new account, or click an existed account to modify his/ her privilege.

There are 3 default privilege profiles of account groups:

Admin: Have privileges to all system functions and devices, except add/delete/update privileges of other users.
Power User: Have limited privileges of system functions and complete privileges of assigned devices.

User: All the privileges of system functions are forbidden, user can only manage assigned devices.

Add: Click it to create a new account after inserting related information. The Add button is only enabled when filled a

new account.

Delete: Click it to delete the indicated account.
Default: Click it to go back to default privilege settings of related user group.

Upgrade: Click it to save the modifications of each account.

Gewral' Camera' licy Dewce' PTZ Config | Hotline  User Account IAddress Book MUmturDispIayl sthck'

[MNarne

[ Group [ Description I

Privilege:

& admin

~User Account
Mame:
Group:
Desctiption:

Password:

Admin Adlministrator

& can't exit ... User

Iadmm
IAdmm -
IAdmm\stramr

Password Confirm I

| Disakle UeerAcoamt
I Keep remote login for 3 minutes

=]

=] Function

-J# Login Main Gystem
Exit Main System
Configure Main System
-J#] StartStop Operation
-J#] Etart/Btop Metwork Service
= Local Backup
.8 Delste Recorded Files
Remnte Backup
-J#] Remote Login
Browse Log
- Login Playback
~J#] Minimize Main System
| Device

E?

ami

Access

Remote Access
PTZ Contral
Remnote PTZ Contral
IMOTEK-FDT13H

L Access

»

-

[E]Etel

[Defat | Update ‘

« 0K | X Cancel |
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User Account Setting: The admin may create and modify the content of user account here.

Name: Insert an user name.

Group: Assign the group for each user.

Description: Insert a description related to each user.

Password: Insert the password assigned to each user.

Password Confirm: Insert again to confirm the password.

Disable User Account: Check “Disable User Account” to block this account.

User Account |
MHame GroLp Description
£ adrmin Adrnin Adrninistrator
£ Guard3 User
& Guardl Powerlser 12345
& Guardz Liser 1273

Note: Only the default admin account cannot be disabled.

Keep remote login for____minutes: Insert the duration to autolog off an account after logging in from remote LiveViewer or Remote
Playback server.

Privilege: Check each privilege of functions and devices for each user account.
Function: Check the settings and operations related system configuration, and the privilege of remote access.
Device: Check the device privileges of camera, digital output in Main Console and client applications.
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The Save/Load Configuration function allows system users to save any specific setting as a .cfg (config) file. You may save up several
different .cfg files at any time.

Save Configuration: To save a specific setting, go to General Setting > Save/Load Configuration > Save. In the popup window,
type in the file name and then save it as a .cfg file.

Load Configuration: To load a specific setting, go to General Setting > Save/Load Configuration > Load. In the popup window,
go to the directory that you saved the .cfg files at, select any one of them and then click OK to load the file.

Note: Main Console will be automatically shutdown after loading a new configuration. Please re-start Main Console manually.

Setting k
Save/Load Configuration k

B Log Viewer
B Backup

MNetwaork Service

About Main Console...
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Network Service

There are 2 types of network services:

Live streaming server and Remote playback server. From the Main Console, go to General Setting > Network Service to obtain the
Network Service panel.

Setting r
Save/Load Configuration r

B Log Viewer
8 Backup

Metwork Service

About Main Console...

Live Streaming Server

When starting the live streaming function of computer, the system allows remote users to log in to the specific computer and view cameras
that are connected to it. As system administrator, user could be able to monitor these accounts in order to maintain the system efficiency.

Main
On Live Streaming Server panel, administrator can see all the clients who are currently logging in to the computer and
watching the live video from the remote side.
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Wetwork Service - 192.168.4.20 x
Main | Black fwhite List| Performance |
Client Caunt o Kill [ k|
State IP Camera Bitrate (Kbps)
Remate
Playhack
Service
Server Status: Stopped
Options
Pott 5150 Default
Maximum Connections: G4
v Use Default Vweb Server
Fart: 80
v Save Log LiveServer.log =
v Enable Audia
’J QK ] ’x Cancel ]

Client List

Client Count: Show the amount of channels that are connected.

Kill Client: Highlight an IP address and click on the Kill Client button to block the client from your client list.
Kill All Clients: Click on this button to block all the clients logging to your system.

Service

Server Status: Click on Start/Stop to turn on/off the server.

Options: Adjust the setting only when the server is stopped.

Port: Assign a port for the clients to connect to your system via Remote Live Viewer. Default port is 5150.

Maximum Connections: Number of connections that are allowed to connect to the system. Default is 64 channels and
maximum is 64, one camera video counts as one connection.

Use Default Web Server: Activate the Web server by checking this box. Clients will be able to watch live video via Internet
Explorer. The port for live streaming server is 80 by default.

Save Log: Save the current log information to your computer.
Enable Audio: Select this option to enable the audio transmission along with video stream.
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Black / White List

Network Service - 192.168 4. 29

X)

Main  Black ! White List ] Performance |

[v Enable White List [v Enable Black List

192 188 . 2 . 20 o | 192 188 . 2 . a0

Rermote

Playback | addtowhiteList | [ Addto BlackList
(] IP Range Access
) 192.168,2,50 - 192,168.2.50 Accept
1 192.168,1.80 - 192.168.1.100 Deny

l Apply to All Metwork Servers l

[J oK l l)( Cancel ]

White List: Check the “Enable White List” box to activate the white list filter. Only IPs from the white list is allowed to log in.
Black List: Check the “Enable Black List” box to activate the black list filter. IPs from the black list will be blocked.

IP Address: Enter an IP address into the IP address field on the left. To add an IP address range to the system, enter 2 sets of IP
address to indicate a series of IP(s).

Add/Delete: Add the IP(s) onto the list or remove it from the list.
Apply to All Network Servers: Apply the settings to both live streaming server and remote playback server.
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Performance

Network Sexvice - 192 168 4 29

Wain | Blackwhits List Performance |

Total bitrate: 0.0Kbps

Rerote
Playback

(200505 4 S6-28] Lhsar LoD J8min Anoapl
SO0EHD0E 4 86 24] Piay Calil 1 aamin
o FLIY CAN 2 38min
4:11] Play CaM 4 aémin
3 Flay CAMR aamin
6] Py CAM 12 gamad
18y CAM 14 Barman

[/ OK ] [x Cancel ]
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Remote Playback Server

When starting the remote playback function, the system allows remote users to log in to the specific computer and withdraw data files that
are stored on it. As system administrator, user could be able to monitor the accounts logging in to maintain the system efficiency.

Main
On the Remote Playback Server panel, all the clients who are currently logged into the computer and watching the playback
video from the remote side.

Network Service - 192.168.4.20 3
Main | Blackihite List| Performants |
Live User Count 0 Kill | [ ke
Streaming
IP User Bitrate (Kbps)
3
Remate
Playback
Service
Server Status: Stopped
Options
Port |5180 Default
Maximum Users: 16
Iv Use Defaulteb Server
Port: a0
v Save Log RemotePlayback.log =
’/ [o]’S ] [X Cancel ]

Client List

User Count: Show the amount of users that are connecting to system.

Kill Client: Highlight an IP address and click on the Kill Client button to block the client from your client list.
Kill All Clients: Click on this button to block all the clients logging in to your system.

Service
Server Status: Click on Start/Stop to turn on/off this option.
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Options

Port: Assign a port for the clients to connect to your system via Remote playback server. Default port is 5160.

Maximum Users: Number of connections that are allowed to connect to the system. Default is 16 users and maximum is 16.
Note: One user counts as one account that is logging in to the server.

Use Default Web Server: Activate the Web server by checking this box. Clients will be able to watch live video via Internet
Explorer. The port for live streaming server is set to 80 by default.

Save Log: Save the current log information.

Note: The server must be stopped before editing any settings.
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Black / White List

Network Service - 192 168 4 29

main  BlackiWhite List | Perfarmance

Live [v EnableWhite List [v Enable Black List
Streaming
| 182 168 . 2 . 40 to 182 . 168 . 2 . &0
[ Add to White List ] [ Add to Black List
jin} IP Range ArCcess
u} 192.168.2.20 - 192.168.2.30 Accept
1 192,168,150 - 192,168.1.70 Dervy

[ Apply to All Metwork Servers ]

[/ 0K ] [x Cancel ]

White List: Check the “Enable White List” box to activate the white list filter. Only IPs from the white list is allowed to log in.
Black List: Check the “Enable Black List” box to activate the black list filter. IPs from the black list will be blocked.

IP Address: Enter an IP address into the IP address field on the left. To add an IP address range to the system, enter 2 sets of IP
address to indicate a series of IP(s).

Add/Delete: Add the IP(s) onto the list or remove it from the list.
Apply to All Network Servers: Apply the settings to both live streaming server and remote playback server.
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Performance

Network Service

Main | Black/white List Performance
Live Tolal tetrate 195 9Kbps Camera 1 bitvale & Tebps
Streaming

A2 acmin
CAM 2 admmn
- ';.l 7 \]':|_I:-|
CAM 12 aarmin

Play CAM 14 3amin

|\/ oK | |x Cancel I
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About Main Console

Go to About Main Console to view the version of your D-ViewCam software and model name information.

I Setting
& User Account Setting D-Link D-ViewCam 3.4.0
SavefLoad Configuration [ f@- © 2011-2012
_ ) D-Link All rights reserved.
B Log viewer
ﬁ Backup http . Awrwrw dlink.com.

Product Information
Model Type: DCS-100

Metwork Service

Ahout MainConsale. ..

IP Camera License Mumber: 32

Device Pack Version: 1.4.4

First Adapter MAC: 00-24-7e-02-20-13
Second Adapter MAC:
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Schedule

Click on the Schedule icon on the Main Console to set up the time duration for video recording.

#: Schedule Configuration

=l 04 Carmeras

9 Insert }6q Delete 4 Configure

EELoad ﬁCopym g |ﬂf| Default |D 1 3 4 7 8 8 10 11 12 13 14 15 16 17 18 19 20 21 32 23 24 [l
=-[& Default i camerat

[&l 01 cameral ] Camera2

= 02 Camera2 ] Camera3

&l 03 camera3 ] Camerad

Start Time | End Time  Record | FPS
06:30 15:45 Always

] Default -

I bf Dy Mode ] I ek Mo...]

Quality | Resolution

v oKk | [X Cancel ]
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Day Mode

Schedule the camera(s) to record video at the same time every day.

There are three ways to setup the time schedule for each camera:
1. Load a preset mode or

2. Insert a new schedule manually or
3. Copy to other cameras after manually setup.

% Schedule Configuration

1 i Load B gy Copy o : |ﬂf| Default |n 12 3 4 5 87 8 9 0 11 1z 13 14 15 16 17 13 1 20 2 31 323 za[iid
A1 Camerat
[l 01 Carneral fi] Camera2
3 & 02 Cameraz fi] Cameras
= 03 Camera3 L] Camerad
=] 04 Carnerad
9 Insert  J& Delete @4 Configure
Start Time  End Time  Record | FPS Quality | Resolution
06:30 15:45 Always
" Default -
2 A Day Mode § [Jweek Mo...
I oKk | ’)( Cancel]
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Load Preset Modes
The system provides six modes to quickly setup recording schedule. Click on the i Load button to bring up the drop-down menu to
select the preset mode. Refer below tables for the definitions of each mode in each series.

Mode Format Time Record FPS Quality Resolution
M-PEG _ _ Max
Regular MPEG-4 0:00 - 24:00 Always Max Max Max
: M-PEG _ _ Max
Office MPEG-4 8:00 - 20:00 Always Max Max Max
M-PEG _ _ Max
Shop MPEG-4 10:00 - 22:00 Always Max Max Max
Highly Secure ——5ecCr 0:00 - 24:00 Always . Max Max
Disk Saving |——jiSEe s 0:00 - 24:00 Motion 10— Max Max
, M-PEG , _ , 5
Minor MPEG-4 0:00 - 24:00 Motion TE— Max Max
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Insert a New Schedule Manually

Step 1
Left-click and draw the bar you want to add to the time table. The scheduled time will show as a grey bar.

& Schedule Configuration §|
i Load B Copy o - |ﬂf| Carnerad |n 12 3 4 5 67 8 9 0 11 1z 13 14 15 165 17 13 19 a0 2 33 33 24 [0
- I& Default il Sunday

+ 01 Cameral fil] Monday

B 02 Cameraz il Tuesday

+ 03 Carnera3 ] wednesday

--i&l 04 Camerad A Thursday
[ Sunday A Friday 3 1
fad Moy 2 ] Saturday
fad Vwednesday l
[ Thursday Lt 3¢ p
[ Friday
[ Saturday Start Time  End Time  Record  FPS Quality | Resolution

-Default Holiday | Customn

l ] Day Mode ] l fJimeak Mo...]

4 b (v o] [x o]

Step 2

Click the Insert icon and add a new schedule in the Regular Mode, i.e. to record video during the time period you set with 30 FPS, Normal
video quality, and Normal resolution.

Step 3
Change the settings by clicking on the Configure icon or double-click the schedule information.

Step 4
Click OK.
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Copy Schedule

You may set up the schedule for each channel/camera by repeating the process above, or simply apply the settings of a single camera
to all the others by clicking the Copy To icon on the top of the display window.

Week Mode

Schedule the camera(s) for each day of the week. In addition, you may assign holidays under the Week Mode.

Default
Follow the same process to setup the schedule for every day in a week.

Holiday
You may assign holidays where the system will work according to the Sunday setting.
Custom
You can assign a particular date(s) on which the system will work according to a special schedule(s) different from the
others.
= Schedule Configuration El
fLoad [ Copyto . ‘ﬂfl Carnerad |n 13 3 4 & 6 7 & o 0 11 12 13 14 15 16 17 18 10 30 3z 23 a4fi
--[E Default i Sunday
#-= 01 Cameral ] Monday
#3802 cameraz A Tuesday
+-& 03 cameras ] wednesday
=& 04 Camera4 A Thursdsy
[ Sunday A Friday
fual Monday A Saturday
Ml Tuesday
[l Wednesday
[ Thursd .
[l Fri;;sy “ B Lot
[l Saturday Start Time | End Time | Record | FPS Quality | Resolution
[ EEEE
’|:| Diay Model [ A Week Mu...]

0K ] Ix Cancel]
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Adjust the Schedule Settings
You can manually change the settings at any time after you insert or load a schedule.

Option 1: Move the cursor to the Time Bar and slide the bar to the left or right to change the start and end points.

Option 2: Click on the Configure icon or double-click on the schedule information on the screen (highlighted in blue) to
open the Encoding Option panel (next page) and change the settings.

# Schedule Configuration §|
g Losd R Copyio . |fE| Default |n 1 3 3 4 & 6 7 8 49 0 11 1z 13 14 18 16 17 13 10 m A 3 z3 z4[did
--[E] Default 7| Camert

= 01 Cameral fil] Camera2
&l 02 Cameraz ] Camera3
=l 03 Camera3 ] Camera4

04 Carmerad

ﬁ Insert &5 Delete m Configure

Start Time  End Time  Record | FPS Quality Resolution
06:30 15:45 Always

] Default -

I ] Dy Mode ] I ek Mo...]

|\/ OK | I)( Cancel]
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Encoding Option

Encoding Options

Original Video

Time Mode Wideo Encoder
Start Time: ooon = (v Always Record {* Keep original viden format
End Tirme: 2359 = I Adjust MJPEG viden frame rate
" Record on Motion: _
Pre-record: a sec. (Max 600 terrrn
0 rl . [ Keep key frarme only
Postrecord: 3 sec. (Max 60 —— {for MPEGH, H.264 )
Audio

[~ Record Audio

’/ 0K ] l)( Cancel l

Pre-record/Post-record Time

The pre-record/post-record function saves the recording data accordingly. For instance, to set up a 5 second pre-record time means the
system will start saving the recording data 5 seconds before the event happens.
Note: The maximum record period is 60 seconds.
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Record Mode

Always Record
Select this option to record video continuously.

Record on Motion

Select this option to start recording when motions are detected. Please adjust sensitivity, the frame interval, and set up the
detection zone to detect motion. Frame interval is the interval in the number of frames between each check by D-ViewCam.
To set up a single detection zone, left-click and drag the mouse to draw a rectangle. To set up more than one detection
zone, simply repeat the same process or click All to select the entire screen.

Note: The maximum number of rectangle detection zones you may create is 10.

Encoded Options

This option is to configure the quality of video. The Original Video window is the original stream from the camera and the Encoded Video
window is a preview of the recording video correspond with the encode settings (on the next page).
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Keep Original Video format
Select this option to reduce the frame rate but not re-encode the video stream to save Hard Disk usage.

* Adjust MJPEG video frame rate: Use the slider to reduce or increase the frame rate.

Note: The maximum FPS (move the slider to the right) will correspond with the original video stream set up on camera
configuration.

* Keep key-frame only: System will only record key frames of the video stream.
Note: The key frame interval is controlled by each camera manufacturer and cannot be adjusted.

Video Encoder

(¢ Keep original video forrmat

| Adjust MJPEG video frame rate

.J'

| Keep key frame only
(for MPEGA, H.264 )
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1 Exit Playback

2 Minimize Window

3 Cue (Start/Stop Point)

Control (Play/Stop/Pause)

Playback

The Playback console allows you to watch the recorded video, view and/or search for unusual events, and view recorded system information.

Speed

Play/Rewind/Fast Forward
Zoom

Scroll Bar

10

11

12

Information Window

Open Record
Volume Control

Screen Division

7 o
: @@

.E L

13 Enhancement

14 | Setting & Save Video

15 | Snapshot & Print

16 | Backup & Log Viewer
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1. Exit

Close the Playback window.
2. Minimize

Minimize the Playback console.
3. Cue

When playing video, click on the Cue In/Cue Out icon to set the starting/ending point of a saved video clip. The Cue In and Cue Out time will
be displayed on the Playback Information Window once they are set.

4. Control
Play, pause, and stop the video.
5. Speed

Control the speed of the playing video. Click + to speed up and — to slow down.

6. Play/Rewind/Fast Forward
Control the video.

7. Zoom
Zoom in and out of the recorded video.
8. Scroll Bar

Indicates the status of the playing video; drag it to where you want to review.

9. Information Window _ . o
Display video date and time, current video status, cue in/out points’ time, and speed.

10. Open Record
Click on the Open Record button to access the Date Time Panel.

11. Audio Volume Control
Adjust the sound level.

12. Screen Division:
Allocate the sub-screen display by clicking on the desired layout. To switch to a single camera display, double-click on a particular
sub-screen. Double click on the screen again to restore the previous screen division layout. To view in fullscreen mode, right-click on
the screen to enable Toggle Fullscreen.

13. Enhancement : Click to open the Enhancement window
L

14. Setting & Save Video: Click E| to open the Setting window and | to open the Save Video window.

15. Snapshot & Print: Click ‘E to take a picture and \ to open the Print window.

16. Backup & Log Viewer: Click | to open the Backup window and E| to open the Log Viewer window.
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Date Time Panel

[t, DateTime Search Dialog [Local Machine]
@ @ _‘i @ 0 Date Time Period Wideo Praview
- (1]
Start Time: 2008 7i & = [20:1500 =] | | ¥ Enable Preview 300810708 30:15:11
1 £A 2009 3 = =
End Time: 2008/ Ti 8 = |20:36:00 =
12324 = =
56 78 91011
12 13[14)15 16 17 18 —
192021222324 25 Color Event Type =
262728203031 General Motion
O Signal Lost
I” Show Records
[~ Show Event Log 3
H‘“ 0708 ¢ g o i1 1z 13 14 15 18 7
[ camera 1
Ecameraz
[ carmera 2
B—r— g4 [» H
Record Always
Record on Motion L'/ oK J [ K Cancel ]
Record on Event

Record Display Window
The record display window shows the information of the available video clips. It may show in calendar or list control view.

L(:j . Remote Server Site: Open Remote Playback Site Management dialog could select to access local machine or set up remote
playback server. Select Folder option could directly access recorded data folder or use Recent List to access previous browser

recorded folders.

Note: To use Select Folder function need password of Main Console.

Refresh: To refresh the record display window.

Log Viewer: To access the Log Viewer Tool.

Previous Days: To show recorded video from the previous recording date.

OCO0L®

Next Days: To show recorded video of the next recording date.
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Date Time Period

Select the starting and ending time points that indicate the time period you would like to view.

Video Preview

Check the Enable Preview box to view the selected video.

Event Type

You can change the color by clicking on the color bar and then click the down arrow.

Time Table

|Cmnr T ‘EventTvpa

T T

ENEDE
CEEEE
CEmEO

COher

» o [———]oener

nal

al Motion
Lost

» Click the = icon to select all channels or the icon to deselect all channels. Finally, utilize the scale bar to modify the scale

of the time table.

* Check the Show Records box to display the time period of recording data.

12 13[14] 15 16 17 18

19 20 21 22 23 24 25 Calor Event Type =
26 27 28 29 30 31 General Motion
] Sighal Lost

v Show Records
[ Show Event Log 3
H‘“ 07/08 | g o 11 1z 1 14 15 15 17
Hcarmera 1
i Camera 2
fcarmera 3

¥

=
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* Click the Show Event Log button to display the time of event detection:

Color Event Tape
Creneral Motion
Signal Lozt

To Withdraw the Record

Step 1: From the record display window at the top left of the Date Time Panel, select the date you want to view the recorded
video from. The red/green/blue lines shown on the time table indicate available recorded video records.

Note: The record display window can be shown in (a) calendar view or (b) list control view. To modify the settings
of the record display window, click on the Settings button at the right of the Playback Console. Refer to the next
page for more detalils.

Step 2: Use color bars to differentiate event types from each other.

Step 3: Highlight the video clip you want to review by left-clicking and dragging the time period. You may also utilize the
Start Time and End Time in the Date Time Period Section. In addition, modify the scale of the time table with the
+ and - signs on the bottom left.

Step 4: Check the Enable Preview option to view the video you select.

Step 5: Click OK when finished.
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Post Processing Tool

General Setting E————
. . . . . Post Processing Tool
Select the option to either apply the filter settings to only the active channels

or to all channels. General Sefting

. . o Apply active channel
Filter Setting

Visibility: Check the box and adjust the gamma value of the image to enhance
the image and make it cleaner.

£ Apply all channels

Filter Setting
Sharpen: Check the box to activate. Move the slider control to the right to [ wisihility
sharpen the image or to the left to soften it. |
Brightness: Check the box to activate. Move the slider control to the right to  Sharpen

make the image brighter.

T

Contrast: Check the box to activate the function. Move the slider control to

[ [ Bright
the right to increase contrast. [ Brightness

T

Grey Scale: Check the box to show the record in grey scale mode so the

image displays in black and white. W e

1 1 1 1 1 ij 1 1 1 1 1
Default: Click to change the settings back to the default settings. [ Grey Scale
OK: Click to save and apply your settings. —— | | oK
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Save Video
Step 1: Click on the display screen to select the camera display that you want to save as a video clip.

Step 2: Click the cue buttons to select the start and end points. The cue in and cue out time will show in the information window.

000 CIICIED 18:21:00

Step 3: Click the Save Video icon. Select the location where you want to save the file at and R
enter the file name. Click Save.

Export File Path:

Step 4: Set the Export Format from the drop-down (ASF or AVI). | w
Expart Farmat:

Step 5: Select the profile to use from the Use Profile drop-down. [asF ~
Uza Profile:

Step 6: Select to export (i.e. save) the recorded video with Audio, OSD (On-Screen Display),
or export video only.

[wiindows Media video 8 for Local Area Metwork (384 ~ |
Start Tirme: 20091 2/07 10:57:00
Step 7: Click OK to save the video.

End Time: 20091 207 10:57:25

[ ExportAudia

[v ExportosD

[./ oK ] [x Cancel ]
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Save Image (Snapshot)
Step 1: Click on the display screen to select the camera display from which you want to save pictures.

Step 2: Click the Save Image button when the image you want is displayed on the screen. You may click Pause to freeze the video and
use the Step Forward/Step Backward buttons to find the picture that you want to save.

Step 3: Check the OSD box to export the image with the date/time and camera number/name displayed. If the digital PTZ function is
enabled in the display view, you can also select either Full size or Selected Region as your image region.

Step 4: You have the option to copy the image to the clipboard or to save it to your computer. Click Save Image and select the folder you
want to save it to. Select the image format (BMP or JPEG) and click Save.

P 108D

!

Save Image ][ Copy to Cliphoard x Close
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P ri nt *’ Print Setop El

Print the current image of the video you have selected.

Print Content: Print the image from the selected channel or all the channels
shown on the screen.

Page Setting: Set to print the image at the Original Size or Fit to Page. Set
the alignment from the Align Image drop-down (Top, Center, or Bottom).

Print: Click to print the image.

Print Content

t« Print active channel irnage;

" Print all channels in the current view

Fage Setting
f« Criginal size
" Fitto page

Align Image: Tap -

[\/ Print Hx Cancel l

The Backup function saves everything from the Playback panel, including log information.

You can start a full function Playback Console and load the backup files into it on any PC with Windows operating system. This means
you may monitor the real time video and work on the backup files on separate computers simultaneously.

Step 1: Press the Open Record button and click Backup.

Step 2: In the Date Time Period section, select the Start Time and End Time you want to back up. || &¢mmereree

Step 3: In the Select Camera(s) section, select the camera(s) you want to back up.
Step 4: Click the Calculate Size button to calculate the size of the backup data.
Step 5: Under Media, select where you would like to save the backup data.

Step 6: Under Option, check the type of data you want to back up.

Step 7: Click the Backup button to start backing up.

Note: The backup cannot exceed 7 days of recordings.

Start Time PN 2 7 1105? o ==
End Time 0001 7 4 |1DS? 25 45

—Belect Camerals)
1418|1732

| cakustesze | [ semctan | [ Desetecta |

Media
& Backup using CDROM
£ Baskiiei
" Backup on HardDisk

Option
¥ Backup Event Log
¥ Backup System Log

[/ OK ] [x Cancel ]
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Log Viewer

Unusual Event

View the unusual event history that had been detected by the Smart Guard System.

Step 1: Select the type of events you wish to view or select All from the drop-down menu to view all types of events. The types
of Unusual Event include General Motion, Signal Lost, and Digital Input Triggered.

Step 2: Select the camera channel you wish to view or select All for all the channels available.

Step 3: View the events that happened on a particular date or during a given time period by selecting the search period.

For a particular data: check the Date box right and indicate the date.
For a period: check the Date&Time and then enter the date and time.

Step 4: Click Search.

Note: When working with a video record, Log Viewer will search for Unusual Event in the video record in Date & Time mode,
start from the beginning to the end of the record, which is the default setting of the system. A link will appear right next to each
event time. By clicking on the link, the video will jump to the point where the unusual event takes place.

- Log Fiewer

B0 =1 |

Unusual Event ]system Log I

Log Type: All

Channel: All

Date: I~ e

Exportto...

DateTime: ||7 2009/06/08 20015~

* 1o [Iv 20090708 2025 - 2

Search

Event Tirne Event Type
2009/07/06 19:22:21  General Motion
2009/07/06 19:28:49  General Maotion
2009/07/06 12:22:52  General Motion
2009/07/06 19:28:56  General Motion
2009/07/06 19:22:10  General Motion
2009/07/06 19:29:12  General Motion
2009/07/06 19:29:18  General Maotion
2009/07/06 12:22:20  General Motion
20090706 19:30:04  General Mation
2009/07/06 19:20:07  General Motion
2009/0706 19:30:17  General Motion
2009/07/06 19:30:21  General Maotion
2009/07/06 12:30:27  General Motion
2009/07/06 19:30:29  General Maotion
2009/07/06 19:30:42  General Motion
2009/07/06 12:31:12  General Motion
2009/07/06 19:31:14  General Maotion
2009/07/06 12:31:16  General Motion
2009/07/06 19:31:30  General Motion
2009/07/06 19:31:36  General Maotion

Camera

0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z
0z

-
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System Log

Select Log Type form the drop-down menu. There are total 23 types of log types, including:

1. Main Console Startup

2. Main Console Shutdown
3. User Login

4. User Login Failed

5. Start Schedule

6. Stop Schedule

Step 1: Select the type of event you want to check or select All from the drop-down menu.

7.Execute Recycle

8. Enable Channel

9. Disable Channel

10. Start Smart Guard
11. Stop Smart Guard
12. Modify Smart Guard

,. Log Viewer

13.Modify Schedule

14. Modify Configuration

15. Start Live Streaming Server
16. Stop Live Streaming Server
17. Modify Live Streaming Server
18. Start Remote Playback Server

Unusual Event System Log |

Log Type: IAII

=]

Date: ([« 200010505 |+ =]

DateTime: |[ ] 2008/05/05 14:53 |8 2007 2009msi05 1458 B2

19. Stop Remote Playback Server
20. Modify Remote Playback Server
21. IP Camera Connection Lost

22. Auto Restart Windows

23. Modify E-Map

Exportto...

Event Time

| Event Type

| Description

2009/05/05 09:54:47
2009/05/05 09:56:22
2009/05/05 13:29:02
2009/05/05 13:29:04
2009/05/05 13:22:10
2009/05/05 13:29:15
2009/05/05 13:47:56
2009/05/05 13:48:31
2009/05/05 13:49:46
2009/05/05 13:50:56
2009/05/05 13:51:35

Main Console Startup
Main Console Shutdown
Main Console Startup
User Login

Start Schedule

Start Srnart Guard
Modify Configuration
Modify Configuration
Modify Configuration
Modify Configuration
Modify Configuration

adrnir

_ Exorto., |
Search

[ -

=

Step 2: View the events that happened on a particular date or during a given time period by selecting search period.

Step 3: Click the Search button.

Step 4: You can export the data to a text file (.txt) or Excel file (.xIs). Click the Export to button, enter the filename, and select the format

to export to.
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Setting - Record Display

General |OSD |

Calendar View (left): SR ——

Display in calendar view. @ CalendarView ¢ List Control
—Play

List ContrOI (I’Ight): [~ Playwhen open

DISpIay in ||St VieW. [ Auto skip when record motion only mode

Mext interval: min

Previous interval: |1 it

alu

—Capture Image

ﬁ;} ! @? =]  Save in cliphoard
L‘/‘:j i ““‘i @ @ L‘/-:j T “"‘-i @ @ = Manually save the image file

4 +H 2009 S — % Pecord Date? A  Automatically save the image file
[# 2009/07/19 o
1 2 2 4 2009707717 Rreferred mageformat. bmp =
4
3 6 7 8 91011 2009/07 /16 =

121314151617 18 2009/07/15 Miscellaneous

20 2122 2324 25 EDD‘;,."'EI?,."'14 ¥ Synchronize video frames

26 27 28 20 30 31 200907 /13 W |
2009/07/12 ] v ok | X canel |

Play

* Play when open: Check this option to start playing the video clip every time when a record is withdrawn.

 Auto skip when record motion only mode: Check this option to set up the system to automatically skip to the points where there
were motions recorded.

* Next interval: Set the interval with which the video goes forward when you click on the Next icon on the control panel.
* Previous interval: Set the interval with which the video goes backward when you click on the Previous icon on the control panel.

Capture Image

 Save in clipboard: The image will be saved in the clipboard and can be pasted to other applications.

* Manually save the image file: You can manually select where you want to save the image, name the saved file, and the format you
want to save the image.

* Automatically save the image file: By pre-setting a path/URL and the image format, the system will automatically save the image
accordingly when you click the Save button in the control panel.
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Miscellaneous

* Synchronize video frames: Select to prevent tearing that may occur in the video display. However, this will increase the CPU
processing load.

OSD Setting

Check the Enable Camera OSD box to display video information on recording video. Information includes camera name, camera number,
date and time. Users also can set up the font, size, font color and any font effects desired.

=

<A

200904121 v
FF064555 |7

=
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Remote Server
Add Remote Playback Site
Click the Remote Server icon to add and setup a remote playback site.

Step 1: Enter the IP address or DNS, Port, Username, and Password. Al Remuate Playback Si: Management

—Sener Setting

Step 2: Click Add to add the server. o sererrame [
agdress [
Step 3: Click OK to exit. pot [0
UserMame |
Password [

Save Passward, [~

Test Server

Add | DE\EIE| Update|

v 0K | X Cancel|

Access Remote Playback Site
Go to the Date Time Panel and click the @ - icon on the top of the display window to access the Remote Playback Site.

¢ #3200

Liocal Machine
Eecent L1zt k
select Folder..

Eemote PC 1 (192.168.1.100)
Eemote PC 2 (192.168.1.101)
Eemote PC 3 (192.168.1.102)
Eemota PC 4 (192.168.1.102)
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Guard

A\ Event and Action Configuration
Event Action

- . . ; . v 0K
Q e | = O & D@ |

ACtion Optionz K Cancel

SR CAMOL DCS-3710
dl Signal Lost

- CAMOZ DCS-5300G
'®. General Matian

--[# Digital Input
[®] DCS-3710 Input:0 (Inpur
[#] DCS-5200G nput:0 (Inp

Widen Preview

=
152

Click on the Guard icon on the Main Console to start the Event and Action Configuration panel. You need to specify an event to be detected
and set up an action in which the system will take when the specified event is detected.

Note: To access the Event Report, click Start > Open Event Report. .

Event Time | Event Type | Camera ‘ Description |
'$.2005/11/21 15:16:14  General Mation g

Cancel Event Cancel All Close
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Event

There are 2 sources of events: Camera (video image) and Digital Input. You can assign multiple events by following the instructions below.

A Eventand Action Configuration

Evert Action

.
W Action Options X cancel

B Signal Lost
=43 CAMOZ DCS-5300G
'8 General Motion
= [ Digital Input.
[] DCS-3710 Input:0 (Inpur
[#] DCS-5200G Input: (np

Assign a Camera Event

Step 1: Select a channel from the camera list and click the Insert Event icon.

Select Event §|
Event Type Description
dESignal Lost Detect wideo signal connection
&, General Motion Detection of any mavement
< >
[J 0K l [x Cancel ]

Step 2: There are two types of events: Signal Lost and General Motion. Select the event you want in the Event Type list and click OK.

Step 3: Configure the setting of the Event Type. Refer to the next page.
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Camera Event Settings
Basic setting of video Signal Lost and General Motion.
Enable Event: Check the box to activate the event.

Life Cycle:

e Automatically cancel event when event disappears: The alarm/action will be cancelled once the abnormality is fixed
or ends.

* Manually cancel event or event continues triggered: The alarm/action will continue until canceled from the Main
Console. To cancel the event, click Start > Open Event Report > Cancel All Events.

* Cancel event after timeout xx seconds: Click the checkbox and enter the time (in seconds) to cancel the event after
the time that you set whatever the events disappear or not.

» Always Activated: Select to have the event enabled 24 hours a day.
* Activated only in the following period: Select and choose a time period to have the event active.

Alarm Event Configuration

Basic

[v Enahle Event
Life Cycle

f« Automatic cancel eventwhen event dizappear

" Manual cancel event or event last triggered

" Cancel event after seconds

Activated Feriod
(+ Always activated

" Activated only in the following period

|\/ (]9 | ’ X Cancel ]
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General Motion
Detect any movement in the defined detection zone.

Alarm Event Option:

* Sensitivity: Click and move the slider control to the right to increase sensitivity so that a relatively small movement will
trigger the alarm. Move the bar to the left to reduce the sensitivity of movement detection. Set up an appropriate Sensitivity
value will reduce the chance of false alarm. For example, you can lower the Sensitivity to avoid the alarm being triggered
by a swinging tree in the breeze.

* Interval: Click and move the slider control to the right to increase interval time so that the alarm will only be triggered when
the movement lasts longer. Move to the left to reduce the interval time.

Region Definition:
* Define detection zone: To detect General Motion, you have to define a detection zone. Left-click and drag the mouse to
draw a detection zone. You may define more than one zone on the screen by repeating the same process. You can also
click on the All button to select the entire detection zone.

Start Simulation: Click the Start Simulation button and test the function on the preview screen.

Alarm Event Configuration

Basic Advanced

Alarm Event Option Video Preview

Sensitivity,. ——— F——
Interval: e
r~

Region Definition
+ Define detection zone
~

l Start Simulation l

[ OK | ’ % Cancel ]
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Digital Input Event

Step 1: Click and highlight the Digital Input on the event type list and then click the E Insert Event icon.

Step 2: Select the device that is connected to your camera(s).

onfiguration

Event

Action

0K
[N -
G CAMODL DCS-3710 Options X cancel

A CaMOZ DCS-5300G
[# Digital Input

Select Digital Input Module

Digital output to signal

Ij0 Module Pin Marne

DCs-3710 o Input 0
DCs-2710 1 Input 1
DCS-5300G o Input 0

7o ] [X cmel]

D-Link D-ViewCam User Manual

81



Section 3 - Configuration

Action

Assign an Action Type

Insert Action: To configure actions responding to an unusual event.

.
A Fvent and Action Configuration
-~ Event Action
- i ) i 0K
% & @ @ E | d [—]
=G CaMOL Camera 1 Action Options X Cancel
& General Motion
[#] Digital Input —
Select Motification Action
Action Type Description
“pplay Sound Play Sound
Bl Send E-Mail Send E-Mal

‘ﬁSigna\ Digital Output Signal Digital Output

v 0K [x Cancel ]

Step 1: Select an event and click the D Insert Action icon.
Step 2: Select one of the three actions you want and then click OK.
1. Play Sound
2. Send E-mail
3. DI/DO

Step 3: Configure the setting of the Action Type if needed.
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Play Sound

The system will play the sound when an unusual event is detected.

Step 1: Select the Play Sound action and then click OK.

Step 2: The window below will appear. Select a Wave file (.wav) and then click the Play Sound indicator to modify the setting.

= liv I@wa\fe j = i O EEE
|4 | Alarm] way
3 |9 | Alarm way
Eipianiapana || J | Dogbarkway
) |4 | OldFhane way
G |4 | Ringer way
=E |9 | Bivenl waw

|9 | Biven waw
|| Sirend e

FAE
-
"
FHAVE IS
-
AR _ERDSEEE
1A 1) | = EEo |
THFELRATY: I Wave Files (*wav) j i
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Section 3 - Configuration

Send E-mail

The system will send an E-mail immediately to given accounts indicating the type of event, the time, and attaching a picture taken while
the event is detected.

Step 1: Select the Send E-mail action and then click OK.

Step 2: From the Select Contactor window select the email address(es) you want to send alerts to.

Marne | E-Mail Address \
AR xxxx HHENENHNA, COM
OF oo oOEN000neLCom
EditAddress Book « 0K ‘ X Cancel |

Edit Address Book: Click the Edit Address Book button to add, delete, or edit contacts.

Please inputthe name and contact information

Name:l Phone E-Mail |

Description: |

Contact persons

[Marne \ Phone \ E-Mail \ Description |

o 0K X cancel
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Section 3 - Configuration

DI/DO

Use to trigger Digital Input/Output devices that are connected to the camera(s), such as alarm lights and sirens.

DI/DO 3

Digital output to signal:

1f0 Module =Ty} arne

OCepartment Cutput 0
CJo-Link DCs-610... Qutput 0
CJo-Link DCs-662... Qutput 0
CJo-Link DCS-523... Qutput 0

oo oo

[ Autormnatically popup FQ control panel
l/ 0K l lx Cancel]

Step 1: Select the DI/DO action and then click OK.
Step 2: Select Digital Input Module and then click the “DI/DO” indicator to modify the setting.

Step 3: Select the device that is connected to your system, that is, the PC you are working with. You can enable the Automatically popup
I/O control panel check box to obtain the correspondent panel to monitor the I/O status.

You should adjust the setting of I/O device in General Setting > Setting > System Setting > I/0 Device first, the 1/O control panel will
display the device status based on it. You can also adjust the size of the panel by dragging a mouse or click the | =|OJ x| on the right
top of the display window.
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Section 3 - Configuration

E-Map

Device and Map

E-Map

E‘ﬁ Map

§ O mimort

i L East
=B Bistro

E|- Device

L Cam3(192188.2.219)

L Camd (192.168.2.213)

..... 2 Cam2

f.of Cam3(182.168.2.219)-Ir -

Information

Cama3(192.168.2.219-0utput 0 (10}
state:OFF

4] | ¥ - N

With E-Map, users can track the actual location and alarm status easily for each camera and receive instant response when the event
happens. The arrows and lightening icon on E-Map represent cameras and I/O devices and these icons will turn red once they are triggered
by alarms.

To launch E-Map application, simply click on Start and select Open E-Map from start menu to open E-Map window.

There are 2 modes in E-Map application:

Edit mode: Allow users to add/edit maps and indicators of devices. In Edit mode, the function buttons on the bottom of the window
will be active, and then setup the configuration before running E-map function at the first time.

Operate mode: All settings will be activated in this mode.
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Edit Mode

You will need to be in Edit Mode to activate the function buttons.

E-Map

@ Cam3(192.168.2.218)
2 Camé (192168.2.213)
<F Camar92.168.2.2191r iy

Cam3f192.1 @3-

F Camd (19216822131

I Add Map | Edit Map | Delete | Rotate |I

~» Camz = P m ’

_..,3003.“9 :ﬂ »® @

_‘1_7]

Function Buttons

Edit mode/Operate mode

Switch button
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Add/Edit/Delete Map

Add E-Map

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Click the Add Map button to load a map image.

Step 3: Select the map file and insert the map name. Click OK, and then the map you added appears in the tree structure in the device

and map list.

Step 4: The map indicator appears on the left-up corner of parent map. Drag it to the position you want on the map.

Map Config

Map lmage File:

Map Mame:

=]

[8].8

|x Cancel |
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Edit E-Map
Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Right-click on the Map & icon to obtain the option menu to edit map, or just click the Edit Map button to open the “Map Config”
dialog.

Step 3: Modify the required details and then click OK to save configuration.

Delete E-Map
Step 1: Make sure you are in Edit Mode and all devices are connected.
Step 2: Right-click on the Map E& icon to open the option menu to delete map, or just click Delete to remove the map from the list.

Note: The root map cannot be deleted.

Add/Rotate/Delete Device Indicator

Add Indicator:

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Select on the Map B icon which you want add device indicator to.

Step 3: Before adding indicator, ensure that the map you want is displayed. Select device from list and directly drag a device to the desired
location on the map.

Note: Different device is symbolized by different indicator.

& - Camera indicator - digital Input indicator
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Section 3 - Configuration

Rotate Indicator

Step 1: Make sure you are in Edit Mode and all devices are connected. Select device indicator from map or form Device and Map list.
The device indicator will be marked with a green ).

Step 2: Click the Rotate button, the indicator will rotate 45 degree.
Note: Only camera indicators are allowed to be rotated.
Delete Indicator

Step 1: Make sure you are in Edit Mode and all devices are connected. Select device indicator from map or form Device and Map list.
The device indicator will be marked with a green 1.

Step 2: Click the Delete button, the indicator will be gone.
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Section 3 - Configuration

Operate Mode

. =B Airport
Co L East
= Bistro

5= Device
®* caml
L@ Cam3{192.168.2.214)
e Camd (192.188.2.213)
2 Cam2
s Cam3(

o o
2000000000 o

e
P | T b Bistro (Map)
b =

[
1921668.2.219)-Ir
92 168 2 21910

Infarmation

g n3A(192.168.2.2149)-C1
LoF Camd (192.168.2.213)-I
g Camd (192.168.2.213)-C

3

o B

Add Map | Edit hap | Delete ‘ Rotate

Device and Map Tree list
This window will list all devices and map hierarchies. Click the Device or Map indicator to show related information in the E-Map window.

Map

Select the map you want to show in the E-Map Window.

»

Camera

Select the camera you want to preview video from in the preview window.

Digital Input

Select to highlight the device with a green ring on the map and show its status in the Information window.
If the Digital Input is from an IP camera, the preview window will display live video from the camera.

E

Digital Output

Select to highlight the device with a green ring on the map and show its status on the Information
window. If the Digital Output is from an IP camera, the preview window will display live video from the

camera.
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Layout Adjustment

Device and Map
=B Map
B Airport

! L East
= Bistro

El | Device

2> cami
@ Cam3(192.168.2.218)
» Camd (182168.2.213)

wops - -«

) "-3..’?9:‘.. ®

Information

ama3i g 3-8
amd (192 168.2.213)-I 7 v
LA camd (192.168.2.213)-C [ l_;,. S Bistro (M)

¥

Add hap | Edit Map | Delete | Fotate ,/ Saye
Adjust layout Window

Shrink the window:

Click the triangular indicators [f= «Jto hide the Device and Information windows on the right and left side. Click triangular indicator again
to go back to the default setting.

Full screen display:

For a computer system with dual monitors, you can view the Main Console on primary monitor and view the full-size E-Map on a secondary
monitor.

Step 1: Click the triangular indicators = « to hide the Device and Information windows on the right and left side.

Step 2: Click on & located on the upper-right of the window to switch to full screen mode.
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Section 3 - Configuration

Log Viewer

/. Log Yiewer i_ E]
Unusual Event ] System ng]
Loog Type: All -
Channal: All -
Date: [v zooamarze - 2 Exportto..
DateTime: I~ 2o T “F Search
Event Time Event Type Camera | Description
2009/07/15 14:45:46  General Motion 03
2009/07/15 14:45:51  General Motion 0z

To launch Log Viewer, Click on General Setting and select Log Viewer from the menu. View the unusual event history that had been

detected by the Smart Guard System.
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Unusual Event

@ Loz Viewer |:E]
Unusual Event lsystem ng]
Log Type: All -
Channel: All =
Date: ’72009109124 e Exportta...
DateTime: ”_ M ] ||— -2 Search
Event Time Event Type Camera | Description
2009/07/15 14:45:46  General Motion 03
2009/07/15 14:45:51  General Motion 0z

Step 1: Select the type of event you wish to view or select All from the drop-down menu to view all types of events. The types include
General Motion, Signal Lost, and Digital Input Triggered.

Step 2: Select the camera channel you wish to view or select All for all available channels.
Step 3: View the events that happened on a particular date or during a given time period by selecting a search period.

For a particular data: Check the “Date” box and select the date you want to view.
For a period: Check the “Date&Time” box and then enter the date and time.

Step 4: Click Search.
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Section 3 - Configuration

System Log

Select the Log Type from the drop-down menu. There are a total of 23 log types to choose from:

oo O~ WN =

Step 1:

Step 2:

Step 3:

. Main Console Startup

. Main Console Shutdown
. User Login

. User Login Failed
. Start Schedule

. Stop Schedule

7.Execute Recycle

8. Enable Channel

9. Disable Channel

10. Start Smart Guard
11. Stop Smart Guard
12. Modify Smart Guard

Unusual Event  Systern Log |

Log Type: IAII

-

Date: ([ 20090505 = 2]

13.Modify Schedule
14. Modify Configuration

15. Start Live Streaming Server
16. Stop Live Streaming Server
17. Modify Live Streaming Server
18. Start Remote Playback Server

DateTime: ||_ 2009/05/05 14:58 [F Zlto ||_ 20090505 14:58 51 =)

19. Stop Remote Playback Server
20. Modify Remote Playback Server
21. IP Camera Connection Lost

22. Auto Restart Windows

23. Modify E-Map

Exportto..

Ewent Tirme

| Event Type

| Ciescription

2009/03/03 09:54:47
2009/05/05 09:56:22
2009/03/035 13:29:02
2009/03/03 13:29:04
2009/05/05 13:29:10
2009/05/05 13:23:15
2009/03/03 13:47:56
2009/05/05 13:48:31
2009/05/05 13:49:46
2009/03/03 13:30:56
2009/05/05 13:51:35

Mairn Console Startup

Main Console Shutdown

Main Consale Startup
| lser Lagin

Start Schedule

Start Srnart Guard
Modify Configuration
Modify Configuration
Modify Configuration
Modify Configuration
Modify Configuration

adrmin

_ wortte.|
Search

[ -

|

Select the type of event you want to check or select All from the drop-down menu for all types of events.

View the events that happened on a particular date or during a given time period by selecting a search period.

For a particular data: Check the “Date” box and select the date you want to view.
For a period: Check the “Date&Time” box and then enter the date and time.

Click Search.
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Export

After you search the log you want, you can export it to an Excel (.xIs) or a text (.txt) file.

Step 1: Click the Export To button.

Unusual Event  System Log |

Lag Type: [l

=l

Date: |[+ 2008m5i05 ~ 2

DateTime: |[— 200205105 14:58 [ =0 [ 20095105 14:50 52

Exportto...
Search

Event Time

[ Event Type

| Description

[ -

2009/05/05 09:54:47
2009/05/05 09:56:22
2009f05/05 13:22:02
2009f05/05 13:29:04
2009f05/05 13:22:10
2009f05/05 13:29:15
2009f05/05 13:47:56
2009/05/05 13:48:31
2009/05/05 13:49:46
2009/05/05 13:50:56
2009/05/05 13:51:35

Main Console Startup
Main Consale Shutdown
Main Corsole Startup
L=er Lagin

Start Schedule

Start Smart Guard
Modify Configuration
Modify Configuration
Modify Configuration
Modify Configuration
Modify Corfiguration

admin

Step 2: Type the file name and select the file format (.xIs or .txt).
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Backup

The backup function saves video records and other log information.

m [Localhost]
S Backup  Help
@ s Mew Period \L.A?Remuve Period @Backup % | Delete
| End Date Time | Camerafs)

N R i) ey
P2009/5/15 EF 10:3300 20004545 L 1046:00 L3

111,1285KE

Note: The backup cannot exceed 7 days of recordings.
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Back up Recorded File(s)

E Backup Systemn [Localhost]

© Backup  Help

4 - & . )

@ T /.)New Period Rermove Period Backup Delete

Start Diate Time | End Date Time | Camera(s Size |
nerals)

Step 1: Click the Remote Sever icon @ to add and set up the backup.

e Enter the IP address or DNS, Port, Username, and Password.

Remote Backup Site Management

¢ Click Add to add the server. - enver seting

58 Iocalhost {localhost)

* Click OK to exit the Setting panel. svertame: [
Address l—
Step 2: To access the Remote Backup Site, click on the g - icon and enter the username/ ~ EEN—
assword of the remote server to access the backup site. yserhiane
p p Password: l—
[~ Save Password:
Step 3: Click on New Period to open the Select DateTime Period panel.  reasom |

Step 4: Select the data you want to back up by highlighting the time period. You may also set ass | oo || e |
up a start and end time in the Date Time Period section.

v 0K | x Cance\|
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%: DateTime Search Dialog [Local Machine]

@ By @ J 7';5‘ @ @ Date Time Period

1~ Video Preview

———————— | Stat Time: 20097 7115 — [oooono =1 | | W Enable Preview
] A 2009 » s =
End Tirme: 2009/ 715 — (00:00:00 =
[zazsa0 1 23 ¢ = =
5676 31011
12 13 14[18] 16 17 18
1920 21 22 23 24 25 Color Event Type =
2012R 20309, 3053 ¢ b + | General Motion
) Foreign Object
Missing Object
% B Rororda cone
E £ - Camera Block |
W Show Event Log Sighal Lost =
= omsls 5w v e w s o s e om  m m sl
Bcamera 1 -} 1 &
[Hcamera 2 =) —} 1
[Hcamera 3 - —1 t
[ camers 4 B '
[Hcamera s L {
[Hcameras o '
Ecameraz | -} 1
[Hcamera s =l —} { 'j
2 Zld [>

——— Record Always

Record on Motion
Record on Event

Step 5: Click on the camera number icon to add camera(s) or click + == to add/

delete all channels.

Step 6: Check the Enable Preview box to display the preview of the video you selected.

Step 7: Click OK when the settings are complete.

Step 8: If there is a data period you do not want, click Remove Period to remove the
data period from the backup list.

Step 9: Click the Backup icon to open the Backup panel.

Step 10: Under Media, select the path you want to save the file or burn the file directly
to a CD (direct CD burning for Windows® XP only), DVD or to a hard drive.
Step 11: Under Option, select the log information you would like to back up (Event Log

or System Log,), and then click OK.

Note: The backup cannot exceed 7 days of recordings.

Backup

Summary
Total backup data size: 71,927KB

Media

“

I

" Backup on HardDisk

Cption
[v Backup Event Log

[v Backup Systerm Log

X Cancel

]
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Delete Recorded File(s)

Step 1: Click on New Period to open the Select Date Time Period panel.

k.’_)lj s Mew Period \__‘A‘;'Remove Period @Backup | Delete

Start Date Time | End Date Time | Camerals) | Size |
2009/5/14 F<F 01-09:00 20095414 F4F 01:32:00 1,2,3,4 f4%,329KE
ﬁZDUQ./SIIS L4 103300 2009/5/15 E4F 10:46:00 1.3 111,185KE

Step 2: Follow steps 3-7 from the previous two pages to select the data period which you want to delete.

Step 3: Click on the Delete icon to remove all the data in the backup list from the database.

Note: The deleted video cannot be recovered.

100

D-Link D-ViewCam User Manual



Section 3 - Configuration

Remote Live Viewer

With the Remote Live Viewer software, remote users may watch one real-time video channel per server from up to 64 remote live streaming
servers.

¥

-
D-View

| [ e

R [
]
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Setting

Click the General Setting icon to open settings dialog window.

General Setting

Audio Preview

FAl Live¥iew Setting

General ]Server] Group | 0SD | Monitor Display | Notification
Audio preview

[ Enahle audio on active channel

Miscellaneous

[ Bynchronize video frames

v

oK | [x Cancel ]

Enable audio on active channel: Select it to enable the audio streaming on active channel.

Miscellaneous

Select to prevent tearing that may occur in the video display. However, this will increase the CPU processing load.
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Server Settings

Ea Live¥iew Setting

General | Serer I Gmup} 050 1 Mummersp\av} Motification

Serer Setting

9 Setver Mame; ’7
Address ’7

N T —

User Name: ’7

Fassword ’7

Save Password: [

Auto Login: [

[ pas | [ pete ][ upaate |

o] (X omen

Step 1: Enter the Server Name as preference.

Step 2: Enter the IP Address, Port, User Name, Password to log in the server.

Step 3: Enable the Save Password to login without entering the password again.

Step 4: Enable the Auto Login to login automatically when starting the Remote Live Viewer.
Step 5: Click Test Server to check if the server is available.

Step 6: Click Add to insert the setting to server list.

Note: To remove the server, select a server on the server list and then click Delete.
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Group Setting

Allocate different cameras into groups.

Fll Live¥iew Seiting

General I Semer  Group I asD } Manitor Display I Motification I

& Insert

=8 Groupl -~ 0 Department 1
&= Department 1 - Camera o Department 2
& Department 1 - Camera &
= Department 1 - Camera | -
& Department 1 - Camera « -
& Department 1 - Camera &
&= Department 1 - Camera ¢
& Department 1 - Carmera
&= Department 1 - Camera §

=8 Group2

&= Department 2 - Camera

& Department 2 - Carmera &

= Department 2 - Camera |

&= Department 2 - Camera «

& Department 2 - Camera ¢

&= Department 2 - Camera ¢

= Denartrment 2 - Clamera;j‘i

|

(75 (X omea |

Step 1: Log in to all the servers that contain the camera(s) you would like to put into the group(s).
Step 2: Click Insert to create and name a new group.

Step 3: From the window at the right, highlight the camera that you would like to add to a group and then click on the <-- button. Repeat
the process until all the cameras you want in the group are added.

Step 4: Click on the Delete button to remove a specific group or click the Rename button to change the name of a specific group.

Step 5: Click OK to save your group.
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OSD Setting

Select the font style and colors of information displayed on the video.

A LiveView Setting X
Genetal ] Sewer} Group  OSD ‘ MomtorD\splav] Motification ]

[V Enable carnera 08D
Foreground

Font T Tahoma 2
Size: m

Color,

v Bold ¥ Edge

Background

Color.

Transparency. 40

Infa
[w Camera Name

—
[~ Date
[~ Time

I™ Bitrate

D-Link D-ViewCam User Manual 105



Section 3 - Configuration

Monitor Display Setting

Activate auto scan to rotate the channels/cameras on screen. For instance, you may select to show only 4 sub-screens on the live viewer
while having 16 channels connected to the system.

FAl LiveYiew Sefting

eneral | Server | Group | 0gD  Monitor Display | Matification

Monitar Resolution

#1 1280% 800 20D SRER
Auto scan group: (Mot Used) -
Frimary channel: (Mot Used) -
Secandary channel: ’W‘
Auta scan interval: ,2— SEC
Layout
Izl Bype: a5 -

< [ES

| oK | ’x Cancel ]

Step 1: Select the Monitor connected to the system.

Step 2: From the Auto scan group drop-down, select a group.

Step 3: Select a primary channel that will always be on the screen when activating auto scan settings.

Step 4: Select a channel that has secondary priority then primary channel on the screen when activating auto scan settings.

Step 5: From the Layout drop-down, select the screen division you want displayed.
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Notification Settings

Status display

Show recording status: Check the box to display the recording status on the monitor display.

EA LiveView Setting

General] Sewer] Group] OSD] Manitor Display ~ Motification

Status display
[~ Show recording status

[~ Shaw camera event

oK | [x Cancel ]

Show camera event: Check the box to display detected events on each channel.
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Server/Group/Camera

Display a complete list of the server(s), group(s), and camera(s) that are added to the system.
Server View: Display cameras sorted by servers.

Group View: Display cameras sorted by group names.

ATy Ay
r r

v [

T T -

D-ViewCam D-ViewCam

=
Department 1 -~ & Groupz -~

af Cameral_1 | B Camera1_1

[ Camera 2_611 afr Camera 2_511

aqp 1 ap 1

lfr Carnera 4_160 afr Camera 4_160

g CameraS_1 0 Camera 5_1

lfr Carnera 6_206 afr Camera 6_206

[ Camera 7_716 0 Camera 7_716

alfr Camera g_140 afr Camerag_140
Cepartment 2 b b
< | = < | =

Server View Group View
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Login/Logout Server

Option 1: Select a server on the list and then click on the Log In icon to access or .
the Log Out icon to leave the server. €

D-V?;\;E.u'n
Option 2: On the server list, right-click to open the menu options.

[ Camera 8_140 &

3
i

dp «

ap

dp «

ap

ey Logout Server

ap Connect Al

ap « Disconnect Al

: .

Connect/Disconnect Camera

B
| 8
-

Option 2: On the server/camera list, right-click on a camera to open the menu D-ViewCam
options to connect/disconnect it.
P

Option 1: On the server/camera list, double-click on a camera to connect it. ‘,_g‘

4 Camera §_140 A
Departrent 2
L=

¥ Came
e _t Disconnect
¥ Came
¥ Came
¥ Came
Logout Server
¥ Came d
¥ Came Connect 4l
S Disconnect &l
T
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Option 3: Select a camera from the list and drag it to where you want the image to be displayed.
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PTZ Control

Control the movement of PTZ cameras. With cameras that support PTZ control, you can move, zoom, patrol, adjust the focus, and set
preset points of the cameras.

Add Preset Point/Go to Preset Point
Adjust the camera view and click on the Set icon and save the view as preset point 01. Adjust the camera view again and set up the preset

point 02. Repeat the process until finish setting up all preset points. Enter any names you want instead of the preset point 01, preset point
02, preset point 03..., click on the Go icon to view the preset points.
Note: To change the speed settings of your PTZ camera, click on Main Console > General Setting > Setting > System Setting > PTZ Config.

Auto Pan

Go to Go to Preset Point and click on Start AutoPan to enable auto pan. Click on Stop AutoPan to stop.
Auto Pan enables the camera to scan an area horizontally from left to right or right to left.

Zoom

Click on the + (Zoom Tele) and - signs (Zoom Wide) to zoom in and zoom out the view.

Patrol

To have your PTZ camera patrol around pre-defined path of preset points, click on the Go to Preset Point icon in the Main Console, and
select Start Patrol or Stop Patrol to start/stop the patrol.

To set up a patrol path, go to Add Preset Point > Set Patrol to bring up the Patrol Setup dialog. From the left window, select the camera(s)
that you would like to have in the patrol group. Align the cameras in order in the right window and adjust the time. Rename the group name
if you want. After completing the setup, check the Active option, and then click OK.

Focus

To focus near means objects that are closer will be clearer than the objects that are further away. On contrast, to focus far means objects
that are further will be clearer than the objects that are closer. Click on the Focus icon and select auto focus if you want the system to
decide the focus point for you.
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On Screen Menu

Right-click on the camera screen and get the “On Screen Menu”, from which you can quickly adjust the setting of camera.

Erabile Move
Enable Cigital PTZ

Enable Audic
Shapshot
Togagle Fullscreen

Enable Move

With cameras that support PTZ, the function allows you to use your mouse to control the PTZ functions by clicking on the display screen.
To enable, click the Enable Move. To disable, click Disable Move to cancel this function.

Enable Digital PTZ

To enable the digital PTZ functions of the video, select Enable Digital PTZ. Use your mouse wheel or click on the + and — signs to zoom
in and zoom out on the camera. The square flashing on the video grid indicates the corresponding view of the camera.

Snapshot
The snapshot function captures a specific video image to the clipboard or to a file you can save to your computer.

Toggle Fullscreen

Switch to view video with full screen display. To disable the function, right-click on screen and uncheck this option or simply press ESC
to go back to original window.
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Start Monitor

Cpen E-Map
Open LD Control Panel

E-Map

Select Open E-Map to open the E-Map window.

o -

Select the map you want to show on E-Map Window.

'}_ Camera

Select the camera you want to preview video and mark an indicator on E-map.

Digital Input

Select to highlight the device with a green ring on the map and show status on the Information window.
If the Digital Input is from an IP camera, the preview window will display live video from the camera.

3 Digital Output

E |

Select to highlight the device with a green ring on the map and show status on the Information window.
If the Digital Output is from an IP camera, the preview window will display live video from the camera.

I/0 Control
Select to open the I/O control panel. The panel allows you to control DO devices remotely.

Note: Adjust the setting of I/O device in Main Console > General Setting > Setting > System Setting
> I/0O Device first, the 1/0O control panel will display the device status base on it.

. I0 Devices

M=%

Servers: |localhost
DI

© o

Input 0 Input 0

—Do

@ O

Qutput 0 OQutput 0
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Playback
Select to open the Playback panel and view video remotely.

Add Remote Playback Site

. . o .
Click the Remote Sever icon L:f:] can go to remote playback site management to add [FEEEEESTIE

and setup the remote playback site. [ Server Seting
9 Server Name: l—
Step 1: Enter the IP address or DNS, Port, Username, and Password. address: |
Part: IS‘\EU—
Step 2: C“Ck Add tO add the server. User Mame: l—
Password: li
Step 3: C“Ck OK tO eX't the Sett'ng panel Save Password: [~
Test Server
Add | [ElETE | Uhdate |

Access Remote Playback Site
v 0K | X Cancel|

Go to Date/Time Panel and click on the LC:j - icon on the top of the display window to access the Remote Playback Site

G-2LEO0
Local Machine

Remote Server 1 {192.165.1.51)
Remote Server 2 {192.163.1.52)

==

13 14 15 16 17 15 19
20 21 22 23 24 25 26
£F 28 29 30 31
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Web View

With the Web-based Remote Live Viewer, remote users may watch one real-time video channel per server from up to 64 remote live
streaming servers.

G?- le oosz168451 B [P e

¢ @ Web Remote Clisat

Remote Live Viewer

Remote Playback

=
-
!-
ao
oo
oo

Note: Make sure the Live Stream Server is enabled. Please refer to Live Streaming Server for more information.
Web View is only supported by Microsoft Internet Explorer versions 7 to 9 (32 bits).
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Server IP

Open Internet Explorer and enter the IP address or DDNS “name” of the server followed by the connecting port.
Example: http://192.168.1.16:8080/

Note: 192.168.1.16 is the IP address of the server.
8080 is the port specified in “Use Default Web Server” in Network Service.

Remote Live Viewer
Click this icon to use Remote Live Viewer.
Remote Playback

Click this icon to use Remote Playback.
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Utilities
Verification Tool

The Verification Tool verifies whether the data created by the system be tampered with or not. It is the process by which a digital watermark
(a digital signature) is added to each recorded video frame to ensure its authenticity.

The 3 types of data that is verified by the Verification Tool are:
1. File in (.dat) (.264) format will be displayed as #* .

2. File in (.avi) (.asf) format will be displayed as o

3. File in (.bmp) (.jpg) format will be displayed as ™ .

il D-Link D-ViewCam F] Backup System

kd DBTook

A Main Console
Playback Svstem
Remote Live Viewer
2 Uninstall D-¥iewCam
A Verification Tool

Step 1: Go to Start > All Programs > D-Link D-ViewCam > Verification Tool.

Step 2: Enter the Username and Password to log in.

Login Verification Tool

Flease enter password far the administrator of Main Consale ;

Lser Mame: Iadmin

Password: ||

(0] 4 Cancel
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Overview

B Verification

EY=NE

File: Marne Waterrnark | Start Time End Tirme Carn Mame Path

CO000Z, ., 2009/05f... 2009{05{... D-LinkDC,..

C:Docurnents and S

4 |
Status Werify
Murmber of Verified Files : 0 files Time elapsed : oo oo ooo
Mumber of Passed Files ; 0 files Tirme left: 0o oo 0on

E} Add File: Click to insert a file to the list for verification.

Wideo Preview

s 1IN

-{! Add Folder: Click to choose a folder with multiple files and then add it to the list for verification.

:1 Remove File: Click to remove the selected file(s) from list.

g’ Select All: Click to select all the files in the list for verification.
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Video Preview: To preview the selected file from the verification list. Use Play, Verify, Pause and Stop for preview.

Note: Preview of .omp and .jpg formats are not allowed.

Verifying Image/Video

Step 1: Select a single or multiple files for verification.

Step 2: Click verify ‘ to start verification.

Step 3: The verification results will be displayed in the Watermark column.

Note: If the file passes the verification, it will show {:5?.

Note: If the file was tampered with, it will show '

B Verification

el=1E" k!
File Narme  ||Watermark || Start Time | End Time | Camn Name | Path :ﬂ
$7C00002... 2009/0S/.,, 2009/05/... D-linkDC... C\Documents an
GwW0a04_S,., 2000/06f,,, 2009/06f,., D-LinkDC.. C\Documents anc
#0604 _sa... & 2000/06/... 2009/06/... D-LinkDC.. C:\Documents anc
$7C00001.., 2009/05f... 2009/05/... O-LinkDC.. ¢i\Documents anc
$#C00001,,, 4@ 2009/05(,.. 2009/05f... C-UNKDC..  cyDacuments anc

2009/0S/... 2009/05/... D-Link DC... C:\Docurments an
»7 CO0002... 2009/05/... 2009/05/... D-Link DC... C\Docurments anc
@/ CO000Z. .. 2009/05/... 2009/05(... D-linkDC... C\Documents anc
e P o o Sy : LI_I
Number of file Verified 7 files Time elapsed : 00 08 : 266
Murber of file Passed : 7 files Time left: 01:49:380

Yideo Preview

> &I

Step 4: The Status and Verify fields will display the information related to verification.
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DB Tools

Step 1: Execute DB Tools from the Start menu.

fl D-Link D-ViewCam EI Biackup System
,‘iﬁ Windows Search ® DBToclk
A Main Console
] Playback System
Eemote Live Wiewer
@ Tninstall D-¥iewCam

Step 2: Enter the administrator password and click OK to log in.

DBTools login

Please enter password far the administratar of Main Consale :

User name: |admin

Fassword: I

| ok | [ concel

D-Link D-ViewCam User Manual 120



Section 3 - Configuration

Repair Database

This page has three repair methods: Modify Location, Verify Only, and Repair.

Modify Location

Playback system can recognize all recording video in the folders which list on Main Console > Config > Setting > General page. For

some reason, users need to use the Playback system to open recording video beyond storage location setting.

Note: The default storage location is in your installation directory, (ex: C:\Program Files\SCB_IP).

Step 1: Select Repair Database.

ﬂnl DBTools (IP version 3, 1,0, 0)

Step 2: Select Modify Location from the Method drop-down menu.

Repair database

Modify locations to store wideo files. Please confirm locations where videa
files were stored and press button "Modify* to confirm.

Repair database

Modify locations to store video files. Please confirm locations where video
files were stored and press hutton "Modify* to confirm.

Install Path: CAProgram FilestiNUUDASCB_IP

Method:  [Modiy Location ~|
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Step 3: Click on the [ button and select a new location.
To remove a database location, select it from the list and click on the & button to delete location.

Wideo File Locations E]

C:\Prograrmn Files,D-Link\D-ViewCarn

Step 4: Click on the Modify button to save the location.

hModify Result: 2 locations confirmed.

Open Log | | b odify
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Example of modify database
In certain cases that video data needs to be transfered from one PC to another, you will need to perform the following procedure:

1. Manually copy all recorded video data files from the default installation path or other user-defined storage path of the old PC.

T
3 C4Program FilesHUUOICE_IP
x | 5 = g

. == = .
i [ IBM ~ L/ d '_.J
[ [BM ThinkVantage 20060321 20060323 niaral
F |5 Installhield Installation Inf
& () Ikl o e
& £y Intemet Explarer ;_J E
& 3 Koei .
B 5 Lenovo wave s ] 3gpp.dll

2. Manually paste all recorded video files to the default installation path or other user-defined storage path of the new PC.
3. Follow previous page to add new location on new PC.

4. Old recorded video data can be viewed by playback system on the new PC.

For verify and repair proposes:

This tool is used to check and repair your database and recording video with below problems:

(1) If there are records in database, but no video file, use DB Tools to delete records.
(2) If there are video files but no record in database, use DB Tools to rearrange the database and find these records.
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Step 1: Switch to Repair Database.

ﬁul DBTools {IP version 3, 1,0, 0)

Fepair datahase

Wodify locations to store video files. Please confirm locations where videa
files were stored and press button "Modify* to confirm.

Step 2: Select Modify Location from the Method drop-down menu.

Repair datahase

tadify locations to store wideo files. Please confirm locations where video
files were stored and press hutton "Modify ta confirm.

Install Path: CAProgram Files\nUUOECHE_IP

Method:  |Modify Location =

Step 3: Check the video location windows. The system will list all video locations in table, but if there are any omit, please use [ to
insert. After inserting location, the system will show a file count table.

File Count; 41

Step 4: Select Verify Only and then click Verify. This method will only check the files without modify. Verify result will show how many
files broken or missing.

Yerify Result: 41 files verified, 0 files broken, 0 files missing.
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Step 5: Choose the method of “Repair (Complete)”, and click “Repair” to repair. The Repair Result will show how many files are fixed and

inserted.

Fepair Result: 2 files fixed, 41 files inserted.

Step 6: The repair new database will replace old ones. And the original database will change file names with extend repair date and time

as below.

: Address |r:| 0:\SCE-IP

Marne
E'_]Eventhg.mdl:u
EHFilerecord.mdb
@FileRecDrd.mdb_EDDEiD?14.'5. 121358.mdb
#Hposkecord mdb
@Scheduletnnﬁg.mdh

@SystemLag.mdh
Eﬂ]ﬁystemLDg.mdb_EDDBD?14n121358.mdb

Note: Open Log is a tool to record repair database recodes. It will recode repair method, file operation, strat time and end time.

Fil= Edit Format Wiew Help
S
Operation "Verify only" is started at (2008/07/14 12:01:17)

File Broken: D:\Video/20080708/c00002/c00002500A20080708112323437 .dat
File Broken: D:\Video/20080708/c00002/c00002500A20080708114304625.dat

41 files verified, 2 files broken, 0 files missing.

oOperation "verify only" is finished at (2008/07/14 12:01:19)

Operation "verify only" is started at (2008/07/14 12:13:19)

File Broken: D:\Video/20080708/c00002/C00002500A20080708112323437.dat
File Broken: D:\Vvideo/20080708/c00002/C00002500A20080708114304625.dat
41 files verified, 2 files broken, 0 files missing.

Operation "verify only" is finished at (2008/07/14 12:13:20)

Operation "Repair (Complete)” is started at (2008/07/14 12:13:58)

File Repaired: D:\video/20080708/c00002/c00002s00A20080708112323437.dat
File Repaired: D:\video/20080708/c00002/C00002S00A20080708114304625.dat
2 files fixed, 41 files inserted.

Operation "Repair (Complete)” 1is finished at (2008/07/14 12:14:07)

B3 1

j dbtoel.log - Motepad [:]@
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Export Configurations

This tool is used when you want to export all configuration settings to a backup.

Step 1: Click Export.

kd DBTools (IP version 3, 1.0, 0)

;a Export Configurations

Renair Export Main Gonsole configurations far trouble shooting. Please
n provide the exported *.cfg file to the technical suppaort .

database
Export

configuration
5

Step 2: Select the location you want to export to and type the name of the config file.

Step 3: Click Save.

-~

Save As W
Savein: | L) SCBAP ~| & @ cf E-

oo Ca i
(Exdump; £ ServerConfig.cfg [Go To Last Folder visited|

ICymanual
Cimdb
[Cskin
(v

File narme: | | Save I
Save as type: | Config Files [.cfg) ~| Cancel |
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Frequently Asked Questions

1. D-ViewCam software supported languages

Bulgarian Chinese (Traditional) Chinese (Simplified ) Czech Danish

Dutch English Farsi Finnish French

German Greek Hebrew Hungarian Italian

Japanese Korean Norwegian Polish Portuguese (Brazil)
Portuguese (Portugal) Romanian Russian Serbian Slovakian
Slovenian Spanish Swedish Thai Turkish

2. How do | set up E-Map?

Please go to <Main Console>-<Start> and then click on <E-map>

Start Monitar Al
Start Recording Schedule
Start Srnart Guard Systemn

Dpen E-Map

Open IO Control Panel

) Lock System
Step 1: Click on <Map>

Step 2: Click on <Browser/ Edit Mode>
Step 3: Click on <Add Map>
Step 4: Choose a map and then fill in the map name
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= Davice
A& [Departrnent
B D-Link DCS-E100 (191163,
B O-Link DCB-1100 (192 168
& D-Link DCS-B62005 (19216
2 D-Link DCB-5230 {192 168
% D-Link DCS-5610 (192163
2 D-Link DCB-B100 (192168
& D-Link DC8-3710 (192,168,
Department-Infut 0
Departrment-input 1
» DEpartment-Ouipur 0
O-Link CCS-6100 (192,163,
w O-Link DCB-B100 {192 168
O-Link DC8-E6200G (19216
w D-Link DCE-BE20G (19216

3. >

Bdd Msp

| Edit Map

il Irma e File:

lap Mame:

[ v

fap (MEp)

Step 5: Click on the map you set

Step 6: Draw the camera or 10 device to the map

Step 7: Click on <OK> to save this setting

A E Moy

- il Wap -~

— & Dewce

A Department
O-Link DC8-6100 (197 168
D-Link DCE-1100 (1932 163,
O-Link DCB-EE20G (192 16
O-Link DCB-5230 (192.163.
O-Link D2 8-5670 (192 168
D-Link DCE-B100 (192 163,
O-Link DCB-3790 192 168
Department-Inpul 0
Cepartrient- input 1
o Department OUlput 0
O-Link DC8-B100 {197 1638
w D-Link DCE-B100 (191.163.
| : ]

Tl Tl Te T T T T

Coexl i

1 Rotats

D-Link DCS-5230 (192,168 0.64) (Camera)
Signal Lost

F -

o Save
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3. How do | back up video files?

User can backup any period of video record into VCD or other drive location, and view those video via playback.exe which
will also be saved in the backup folder.

Please follow those steps to backup your video record: Setting g
Save/Load Configuration 2

Step 1: Go to [General Setting] ->[Config]->[Backup]
B Log Viewer

orcwr

MNetwork Service

About Main Console...

Step 2: Click on [New Period] Bl s it EE—

Backup Help

@ © pNew Period Remove Period Backup Delete

Start Date Time  [New Period)d Date Time Camera(s) Size

Step 3: Set start and end time for time period 3 e s toter) S T ==

Step 4: Select cameras what you want to backup #R00 T 3| | ¢ o

Step 5: Click [OK], and period will show s T P

(28203031 1 2 3
= 45678910 e
#/111213141516 17

<1819 20 21 22 23 24 Color | Event Type |

=25 26[27]28 29 30 1
% 2345678

General Motion
Signal Lost

=
-

-
-

E=

i 0-Link DCS-52
5 camera 2

{5 camera 3

i camera 4

fH camera 5

5 camera 6

fH camera 7

fH camera 8 ~
B —r— Bl »

L&
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Step 6: Click [backup]

Bachp  Hep

- WewiPericd | Ramae Period :L"nnd-u
Start Date Tme Erd Duste ﬁ Comralt) Soe

Step 7: Choose a location to backup media Backup x|
Step 8: Set option to backup log files. ~ summary —
Step 9: Click [OK] to execute backup Total hackup data size: 52,826KB

Step 10: After backup, you can execute the playback.exe

to check the backup files e

" Backup using COROM
= Backup using DVD

ID:I

:

ﬂ?ptinn —

v Backup Event Log

v Backup System Log

\_

0K | X Cancel‘
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Backup Video Database...

Rebuilding database and copy required video Files
Backup from Z010/2/8 PM 06:10:15 to 2010/2/8 PM 06: 1100

[LIT] J L Cancel I

\ ? ) Backup is completed, Do you wank to execute viewer?

i}
T
* B
e e [ ]
i i LT L -
i e e A
EE T e B LT 1| 1

LLTL I -t S s e
@l ol Appinaree riwresn o200 | G
S el e e M S A
Ll Applneien Priersae G0 WEND |
EETAE g e ot W e e
Hel  Applcaee Drieser 0L X AN
O gl e Lbaeaee MW G e
JESE  Appinser Deese DS S N8R
(L TE R T R
Sal Appwee | ey CAERCTDDO 5 AT e
BRIt B B SRR
| - Applaee [derese @ DATES TOD P
A g it e LRI B R
Tl Applwer Diereee (0660007 O B
FRal gl aee Doiwrame oy - 80000 | i
IR M OFee & 1 MTED R
Tl g ol P e BT & L
I e Oy Sox . LAY 3R
1l Pl R LIZENET L

D-Link D-ViewCam User Manual 131



Section 4 - FAQs

4. How do | enable audio in live streaming for IP cameras?

In order to save bandwidth, the default setting for audio is disabled, user needs to enable this function manually, please
follow those steps.

- - o Setting E\
Step 1 - GO to [Conflg]--->[settl ng]--->[GeneraI] please Camerai 1i0) Device | PTZ Ganfig | Hotline | Address Book | Monitor Display |
enable [Preview Active Channel]
[~ Main Console Location @E ¥ Current Date
- [~ Schedule Recording System CP Fies\D-Link\D-View: FeCreri
Step 2: Default channel means the background audio of L e SR s
camera channel. X o —
I EllBereen ¥ IF Camera Bitrate
[~ Auto Login e [ UszerDefined Text 1
& Recycle when disk space is
less than 10 % [~ User Defined Text 2
 Only keep video for ’— days
Miscellaneous

[~ Automatically popup event report
I™ Minirnize to systern tray

[~ Synchronize video frames

Step 3: Switch audio channel

When choose sub-screen 1, you will hear audio from camera 1
When choose sub-screen 2, you will hear audio from camera 2
If you don’t choose any sub-screen, you will hear audio of
default channel.
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5. How do | record audio for IP cameras?

Step 1: Execute Main Console and go to
[Schedule] -> [Configure] -> enable [Record Audio] -> [OK]

Step 2: Start Recording Schedule [Start] -> [Start Recording
Schedule]

6. How do | change the recording frame rate and the
resolution for IP cameras?

The recording frame rate and resolution are the same with live
video, please follow those steps for adjustment.

Step 1: Open up Main Console and go to
[Config] -> [Setting] -> [Camera]

Step 2: Select the camera of which you want to change the
frame rate

Encoding Options

Original Yideo

Audio

v Record Audio;

lw Encoded Yideo

Time Mode
Start Time ooon = Always Record
End Time: 359 45
" Record on Motian:
Pre-record: ] sec. (Max B0} —_—f—
Postrecord: '3_ set. (Max 60} —_——

Video Encoder

* Keep original video format
I Adjust MJPEG video frame rate
e

™ Keep key frame only
({for MPEG4, H.264)

o 0K X Cancel

& Setting

P Seach (lnset PDelete o Confle

General Camera |\r0 Device | PTZ Config | Hotline | Address BEIEIK‘ MunnurD\splav‘

& CAMO1 Department
Pt - a2 DCS-5300G

Camera Parameter

DCE-5300G

Camera Setings

—EETEE———

08D Betting
|v Enahle
I~ Date
[~ Time

Iw Camera Number

Iv Camera Name Fant

[ Bitrate

200911013 ud
PrO4:51.00 =

Apply All

7o) [ oo
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Step 3: Click on [Camera settings]. And then you can change
the frame rate, the resolution, the quality, etc.

7. How do | set multiple storage paths for video recording?

& Setting
General Camera | 1o Device | PTZ Gonfig | Hotline | Address Book | Monitor Display |

e Search {Insect P Delete | @4 Config

&5 CAMO1 Depar tment
{5 CAMO2 DCS-5300G

Focornans =
__Camera Settings v Camera Mumber

I Bitrate Apply Al

[./ QK }[x Cancel]

Our Main Console allows you to set up several hard disk drives as the storage location. When the first hard disk is almost full
(the capacity is less than 800MB on system disks or 100MB on non-system disks), Main Console will try to find a second storage

with enough capacity.

If no more capacity is available, Main Console will start recycling if auto-recycling is enabled.

If auto-recycling is not enabled, recording will stop.

Please go to [Main Console] -> [Config] -> [General] -> [Storage Location] to modify your settings.
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M Seiting

X

Ganeral | Camera | 110 Device | PTZ Config | Hotiine | Address Book | Monitor Display |

Startup Slorage Status Display
[~ Main Console e [+ Current Date
[ Schedule Recording Systern C:\Program Files\D-Link\D-viewCam v Current Time

[~ Smar Guard System

[ Live Streaming Serer

W Login User
| Free Disk Space

[~ Remaote Flayback Servar
[V IP Carmera Bitrate

[~ Full Scraen
Auto Lagin [~ User Defined Text 1
L 2 Automatic Recycle:
i Recycle when disk space is
less than 10 % [~ User Defined Text 2
 Only keep video for 7 days
Log Recyeling ]
~Miscellaneous Audio Preview
[ Automatically popup event report Default Channel (Mot Used) -

) Ll il I~ Enable Audio on Active Channel

Yolurme — J—

™ Synchronize video frames

‘\/ oK J ’x Cancel]

8. Why do | get “Disk space is low and the scheduler has | Emer (55
been shut down. Please check the storage location setting

”
to recover”? a Disk space i5 low and the scheduler has been shut down,
Pleae check sterage location setting to recover,

The error means recycling is not working, please follow the i oK
steps to diagnose this problem.
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Step 1: check the setting and configuration

Make sure the auto recycle option is enabled in Mainconsole setting.

Make sure auto login, auto startup of Mainconsole and schedule are enabled in Mainconsole setting.

Remove NOD 32if NOD32 is installed since it will generate a great amount of log files (.tmp files) with tremendous size to
occupy a lot of hard drive space and cause stop recording.

Do not adjust the system clock after recording is started.

Do not unplug removable disk when system is recording.

Check if any quota limit is set in your hard drive.

Check if the hard drive is set as “read only” or if a folder named “1” exists.

Check if the hard drive is damaged or there are bad sectors inside.

Make sure you do not use network hard drive.

Step 2: If system stops recording which is caused by insufficient hard drive space.

Check the recording paths are the same in FileRecord.ini and Storage location.

Remove the oldest few day video folders or move them to other hard drive.

Check dberr.log (it can be found in D-ViewCam installation folder). If there are a lot of errors of Eventlog and Systemlog in
dberr.log, and Eventlog.mdb and Systemlog.mdb is oversized caused by extremely frequent events or scheduler is set as
record on motion while the cameras focus on a dynamic background.

The space for system hard drive must be more than 800 MB and the space of data hard drive must be more than 500 MB for
Mainconsole to run recording.

If you still experience stop recording, please use DB tools to repair/rebuild database to re-associated recorded video.

9. Why do | get “Live streaming server can not be connected”? Efron ri‘ |

In general, this error message is caused by network problem so always
check your network connection first.

If you are connecting to a remote server or device through WAN.
Please make sure the remote server or device is not behind a router's [ Ok |
firewall or the port is forwarded properly to bypass the router's firewall.

9 Live streamineg server can not be connectad
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10. Why do | get “Cannot load database template. | Eror ==
Please re-install the system to solve the problem”?

o 1 Can't properly load database template. Please re-install the system to
You will receive this error message when Mainconsole S solve this problem.

experienced a critical error when loading the
database.

This problem is frequently observed on Windows Vista S oKk
due to its tightened security system.
There are two ways to fix.

1.) Turn off UAC in control panel on Windows Vista.
2.) Enable the privilege level option in compatibility tab
in Mainconsole properties.

11. Why do | get “Missing or corrupted resource files. Please re-install Errie |
the system to solve the problem”? -

Missing or corrupted resource files.
Please re-install the svskem to sobwe this problem.

This error message occurs when the software failed to execute the
necessary file for the requested operation.

(1) Occur when loading Mainconsole

The skin files or database may be corrupted to cause this error message.
Please uninstall the software, remove D-ViewCam folder in C:\Program Files\ and install the latest version.

(2) Occur when loading ActiveX of web live viewer/ playback

Please follow below instrument for troubleshooting.
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1.) Turn off UAC in control panel on Windows Vista.
2.) Enable the privilege level option in compatibility tab in Mainconsole properties.

12. Why do | get “The procedure entry point WMCreateWriter could not be located in the dynamic link library
WMVCore.DLL.”?

If you met the error message as follows, please upgrade your windows media player and this problem will be fixed.

LiveYiew.exe - Entry Point Mot Found EET ﬂ

Q The procedure entry poink WMCreatewriter could not be located in the dynamic link library e Core, DLL,

Q.

Playback.exe - Entry Point Mot Found il

° The procedure entry point WhCreatei'riter could not be located in the dvnamic link, library WiihCore, DLL,

2K

Please download the latest Windows media player here, http://www.microsoft.com/windows/windowsmedia/default.mspx
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13. How do | start network services?

Step 1: Go to General Setting -> [Network services], and you will
see
several services you can use.

Step 2: Please remember to click on [Start] of the services you want wain | =
. R v Black / White Llst] F'errormance]
to start in Main Console. : : :
Client Count o | Kill | [ Kill Al |
State IP Camera Bitrate (Kbps)
Remote
Playback
Remote Senvice R
Desktop Server Status: Stopped Start Stop
Options
Central Port [6150 [  Defaut |
Management Maximum Connections: 64
¥ Use Default Web Server
Port: 80
¥ Save Log |LiveSeNerI0g (=8
[¥ Enable Audio

|/ oK | |)( Cancel|

D-Link D-ViewCam User Manual 139



Section 4 - FAQs

14. How to configurd my PC/Server to allow remote access for the

viewer and playback?

In order to view remote live viewer and remote playback from the

internet, there are two things you have to do.

Step 1: Start <Network Service> in Mainconsole
Please go to <Main Console> - <Config> - <Network Service> and

then start this service.

Our default port number for live streaming is 5150.
Our default port number for remote playback is 5160.

The default port for web browser is 80.

If you need to change it to another one, please don't forget to set it to

port forwarding on your router.

Network Service - 102.168.4.32 r>_<|
Main | Black/white List| Performance |
Client Caunt 0 Kill [ kman ]
State IF Camera Bitrate {khps)
Remote
Playback
Senvice
Server Status: Stopped
Options
Emit [ 5150 [ Defaul ]]
Maximum Connections: 64
W Use DefaultWeb Server
Part: a0
v Save Log LiveServerlog [}
Iv¥ Enable Audio

’/ 0K ] [)( Cancel ]

Network Service - 102.168.4.32 X
Main | Blackwhite List | Performance |
Live User Count 0 Kill [ kman ]
Streaming
IP User Bitrate (Khps)
Service
Server Status: Stopped
Qptions
Fart: |5150 Default
Maximum Users: 64
v Use DefaultWeb Server
Port: 80
v Save Log RemotePlayvback.log m

[/ Ok ] I)( Cancel ]
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Please notice that if you met the following error message, it means your
port 80 was occupied by the other device, therefore, you have to

change it to another port number. ST R
@ Pleaze check if other application occupied port B0

Step 2: Enable port forwarding in your router
After that, what we have to do is to find the public IP address of your router and set port forwarding on the router to NVR
LAN IP.

* You can see the public IP address of your router in its configuration menu.

* You can also configure NAT (or port forwarding) port 80, 5150 and 5160 to your NVR'’s LAN IP (e.g. 192.168.3.30) in the
router.

* Port forwarding looks something like this in your router:

You have to forward 3 ports, one for 80, one for 5150 and one for 5160.

. Acceszories i
All 3 ports should point to e.g. 192.168.3.30 B St il T Wi

| Calculator
- . [ Formm =
After you have successfully forward the 3 ports in your router, you will be able to @5 Conne, Open
access remote live viewer and remote playback from the internet. "7 Notep & Run as administrator
4 Paint Open file location
15. Why can’t | see live view and video playback on Internet Explorer after ‘& Remot S YT A
up grading to the latest version? ST Run | o WinkAR "
& o
E SZLP:; Pin to Start Menu

It is often caused by the old temporary IE components in Windows. Please remove @ syncc Addto Quick Launch

the old IE components and reinstall ActiveX to solve the problem. B Welcol

Send To »
Windo
Step 1: Closed IE and all of its related applications first. Otherwise some files may ; Windo! Cut
be locked during removal. If your OS is Vista, please run "Command prompt" as B Windo Copy
administrator first or you will not able to remove the components. =) WordP
Eaze of Delete
Rename
1 Back Properties
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Step 2: Go to [Start]->[Run]->key in: cmd and press [OK] Run dl

Type the name of a program, folder, document, or
Inbernet resource, and Windows will apen it for you

Open: | omd]| w

[ 2 | Cancel H frowse. .,

C:AWINDOWSsystem 3 2\emd. exe

Step 3: Key in: cd C:\WINDOWS\Downloaded Program Files —[CRSSSEstiEe IpH Rt
Step 4: Key in: dir to list all objects on this folder ? ent Settingsianue? of O WINMOUSIDoenloaden Progean Files

Step 5: Key in: del /s . —— — — :
Don't forget the Period (.) after /s % a5 20m o4:2 b T
Step 6: Keep pressing Y when prompted to delete all the files t P | et
in the folder

UAPGDec
UAT
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Step 7: Key in: rmdir /s .

Don’t forget the Period (.) after /s

Step 8: Keep pressing Y when prompted to clear up the
remaining files in the folder

o+ CAWINDOWS\systam 3 2\vem d.axe - 0%

icwrocoft Wimdowe XP [Ueapcion 5.1.2688] a
ight 1985%-2881 Hicroszoft Corp.

CzDocuments and Settings SGlrcd C: NINDOWS Downloaded Program File

2= SHWINDOYE ~Down loaded Program FilesPradir A=

Step 9: Key in: dir and press [Enter] to check if the folder

is empty.

Step 10: Complete. You can now reinstall your ActiveX with
web remote client.

16. What ports for network service are used by default?

The default ports can be changed however you like, but we strongly recommend you avoid using ports below 1024 because
they are often used by other system services.

Service Port Purpose

Live streaming 5150 Communication between desktop remote live viewer and Main Console

Default web server|80 | Access protocol of web based remote client
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Remote playback 5160 Communication between desktop remote playback and Main Console

Remote desktop 5140 Remote access to Main Console

17. Can | hear the audio at D-ViewCam remote live viewer 8 _ i
N N General  Camera IIJO De\llcel FTZ carg | Hu1llne| Address Book | Monitor Dlsnlw]
application and Internet Explorer browser? eIy
arsi t P Deler | 9 Config

(ST ST S
7 MR
& £ caMOoL Department

. . . B & Camie o-Lirk 0CS-6100 (192, 168
Yes, please right click on the screen and check <Enable Audio>.  |B&camounocs1um Ges e
[ 5 CamMo4 D-Lirk DOS-56205 (102
| B & CAMOS DHLirk DOS-5230 (102, {f ST
B & caMo6 D-Link DCS-5610 (192,

Please do not forget to enable audio at Main Console first. .

; Image Cuality
& A& CAMOS CrLirk DCS-3710 ¢182, i | j
H - Frams Fate: IIIIIIIIIII an
If you are using IP cameras, please go to <Main Console> - S i
- - . E SqE—— pghest
<Config> - <Setting> - <Camera> - <Camera Settings> Aassion | o0
i)
bl
[« ok | [% cancel | [z0100 2200 -
PMO443:00 1-]
[ Camera BEMINDS | W Carmera Mumber
| \ideo Pararmetsr ] W CameraMame T

[~ Bilratz __.&JJI:WAII

[
| s

lv" ak ][ﬁ Cantelj

D-Link D-ViewCam User Manual 144



Section 4 - FAQs

If you are using analog cameras, please go to <Main Console> - o setime %

. . . . General |Camera| 10 Device | PTZ Config | Hotline | Address Book | Monitar Display |
<Config> - <Setting> - <Audio Preview> . : St i

I~ Main Console e QEE)E) | | W cumentDate
I Schedule Recording System CiAProgram Files\D-Link!D-ViewCam W~ CurrentTime
I~ Smart Guard Systern
™ Live Streaming Server
I~ Remote Playback Server

™ Full Screen

User Defined Text 1
I~ Auto Login Automatic Recycle .

Sefup = Recycle when disk space is

less than % I User Defined Text 2

10
" Only keep video for 7 days
Log Recycling

¥ Login User

I¥ Free Disk Space
¥ IP Camera Bitrate

I~ Autoratieally popup event report Default Channel (NotUsedy -

L I e [ Enahble Audio on Active Channel

Wolume = Ji

I~ Synchronize video frames

-

After that, please go to remote live viewer and right click on the screen
to check <Enable Audio>

;

i

ji

i
o
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18. Why my IE8 doesn’t work well with D-ViewCam software ?

In order to install ActiveX under IE 8 environment, we need to setup
following settings.

Generally, there are two settings to make it work.

First of all, please make sure ‘vcredist_x86.exe’ has already been
installed.

Step 1: Add the Server IP into Trusted Web Site.

/= Remote Live Vies

w - Windows Internet Explorer

G-

L ;9__ hitp:192.168 4. 3281 Aiveview-himlshinLive View himl

W 40| @ Remoke Live View

= Yahao! - Windows Infernet Fxplorer

G-
Fle  Edk  Wiew Favorites
¢ Fawories ek F

&vehoa!

My ¥&hoo

YAHOC

Meks 7 your homeg

b Departrent_1
P DCS-5300G_1

MY FAVORITES
B vew rancor snes
& vanoot mai

g Awos

li Facebaok

[l Fmance oew ionee

B Games
<

Enables wou to chanpe sedings.

g

vahoo.com o B x & o
-
Cbate Brovesing Hebary... brk-Shift+-Del
- InPreas Browsing Ctrh-shift4+p
Feaopen Lest Browsing Session M - Pagev Sefstys Tk e T
rPtvans Flteting CtrkSHf+F | F
IrPraca Fltenng Sattngs | LOCAL SHOPPING MORE 7
|
Pap-up Blocker 3|
Smartacreen Flker L |
Manage fdd-ons |
1
Compatibity Wiew | Signin N
i ity Miew Settings
POPULAK
1. Kaky
Windmes Lipdste 2 Andy
Davakopar Taols Fl2 9 Mich.
Windmes Mess=nger 4 Us
Cizgrogs Connection Probiems... i MDA
r ] T Yahoo! |
o —— S— Fined exche
Most stressful cities in America .
»
4 ®ior -
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General | Security |F‘riv.-'ar.3|I | Content I Connections I Programs | ndvan::ed|

You can add and remove websites from this zone. All websites in
this zone will use the zone's security settings.

® Add this website to the zone:

Select a zone to view or change security settings.

Internet  Localintranetl Trusted sites § Restricted
sites
Trusted sites ; = Ebsﬂ:es: ;
This zone contains websites that you — http://192. 188, 1. 100 | Remove
trust not to damage your computer or
your files,

You have websites in this zone.

Security level for this zone

Allowed levels for this zone: Al

[] Require server verification (https:) for all sites in this zone

Low
- Minimal safeguards and warning prompts are provided
- Most content is downloaded and run without prompts
- All active content can run
= - Appropriate for sites that you absolutely frust

[] Enable Protected Mode {requires restarting Internet Explorer)
l Custom level. .. ] l Default level ]

’ Reset all zones to default level ]

Coc ) Lo ][ sy
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General | Security |Pri1.rar.y I Content I Connections I Programs | ﬁduaﬂr.:edl

|&® \NET Framework
Select a zone to view or change security settings. ._ﬁ Loose XAML

i) Disable
@ @« v O
’ . X () Prompt
Internet  Localintranet QR EEEE — Restricted =%
_ it ,_ﬂ ¥AML browser applications
() Disable
@ Enable

Trusted sites

This zone contains websites that you =)
(") Prompt
trust not to damage your computer or o8
your files, [#= XPS documents
You have websites in this zone. (") Disable
@ Enable
) Prompt
Fr NET Framework-reliant components
Low % Permissions for components with manifests
- Minimal safeguards and warning prompts are provided B Micahde
- Mozt content is downloaded and run without prompts 1| [TI] |

- All active content can run
- Appropriate for sites that you absolutely trust *Takes effect after you restart Internet Explorer

Security level for this zone

Allowed levels for this zone; All

=)

Reset custom settings
[T|Enable protected Mode (requires restarting Internet Explorer) -

Reset to:
[ Custom level,.. ]’ Default level l Lese 'i_uw l: ' Reset,.. l
=

[ Reset all zones to default level

ok || cancel

D-Link D-ViewCam User Manual 148



Section 4 - FAQs

Step 2: Add the Server IP Compatibility View Setting

Compatibility View Settings

L,_\E] ¥ou can add and remove websites ko be displaved in
& Compatibility Wigw,

< Yahoo!  Windows Intermer Fuplarer

G RO e—— kel
Pl ElE Wi P m Heba Add this website:
e P Dielebe Brovwsing Hastory. .. Chrl+ Shift+Del | | Add
W Favortes | gy TnPrivate Erowsing i+ Shit+p -
5 Pahaal R.enpen Lagk Browdng Session W= paga - safety - Tods - e =
: : S
i InPrivate Fikerng T ~ Wiebsites you've added to Cornpatibiliey View:

TnPrivate Fikering Settings LOCAL SHOPPING ORIl 192,168,.1,100 Remoye
H Fog-up Blodser ¥
A Oc SmartScresn Fiker ¥

Manage Add-ans

WMy ¥ abod Wake " pour homeg

omp kbl
Competibiiey Yie

MY FAVORITES . PCOPU
i K
el View Yahoo! Sites
. “Windaws Update 9 B
¥ahao! Wil Erasileiis Tatks Fi2 T
a - wWindaws Messengar 1 U
Ciapnose Connechion Proglems. . 5 M
Facabook g :
K Tteerist Opticns / [ 1Incude updated website lisks from Microsoft
| — = P s ¥ahe . : L et :
g - - " - e o Display intranet sites in Compatibility Yiew
Games 0s ress c s in America . . . Ao .
it sttt R | & D [ oisplay all websites in Compatibility Yiew
] Hotobe home values create high anxiety far 2y gtreas relef ot work

e rasidartds hars o Coenesd mlasas B L .
< 3 Close
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{2 Web Remot Client - Windows Infernet Explorer

¢ LiveView - Windows Inlernel Explorer

°~»' & /192168451 RICIEE | P — - - .
7 p @ i w |l 192168450 4/|x : L~
T LiveTiew
-~
Remote Live Viewer
Login - 192.168.4 51 192.168 .4 51
@ Flease enter user name and passwaord far live server
Remote Playback Lagin
Server, 192.168.4.51
User Mame J|
Pagsward: ]
oK Cancel
-
< >
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Enjoy 3.2 web live viewer with Internet Explorer 8.

Step 3: (Optional) If the instructions above doesn't work, please try the following method.

~ Yahao! - Windows Internat [xplorer

a. - 2 vahoo.com’ ¥ B[] [
Fle Edi  Wiew Faworites n Help
i roveies | oyl Cebate Browsing Hoory... Ctrh-shift+0e
InPriana Browsing Ctrh-shft4P
@ vzhoa! Rsnpen Last Browsing Sesacn M - Pag v Sdetyr Tmkr g T
IrPrbyans Flteting ChrksHft+F a
InPrivaca Fltenng Sattings LOCAL SHPPNG WORE 1
c Pap-up Blocker 3
A_HO SmartScresn Fksr k
Manage fAdd-ons
My Yenoo!  Maks YIypurhomed  Compatbity View Sgnin N
Compatibilty Wiew Settings |
WY FAVORITES g POPULAI
Bl view ranca snes s
Wind s Lipdste 2 Andy
Yahoo! Mal Duveloper Tacls Fl2 1 Mich:
B il Wind s Mess=nge 4 US
Cimgriocs Carnection Problems... 5 MDA
l’i Facebook AR b Mt T
rbarnet Optor
¥
ﬂ Fnance Dow Jonoe 4 Yahoo! |
r cary - - Fimd exci
Bl Games Most stressful citias in America “
£ ¥
Enailes vau toochenge setongs, ar Kuors -

Internet Options

| General | Security | Privacy | Content | Conmections || Programs | Advanced [

Settings

[] oo not save encrypted pages ta disk A
[] Empty Temporary Inkernet Files Folder when browser is clo
Enable DOM Skorage

MR Enble memaory protection bo help mitigate online atta

%] able Tiatlve 2 H F sLppo
Enable SmartScreen Filker
[] usessLz.o

Use 551 3.0

Use TLS 1.0

Warn about certificate address mismatch®

[] arn if changing between secure and not secure mode

Warn iF POST subrittal is redirected ko & zore that dossn__|
“

&| I | 3

*Takes effect after vou restart Internet Explorer
Restore advanced settings

¥ou should anly use this if vour browser is in an unusable skate,

Reset Internet Explorer settings —

Resets Internet Explorer's settings to their default
condition.
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19. What is the version of my software?

In [Main Console] -> [Config] -> [About Mainconsole...]

sl Setting e
D-Link D-ViewCam 3.4.0 I
& User Account Setting ¥ o
; o D-Link All rights reserved.
Save,/Load Configuration k i anen i comy
E LDQ "l.l"iE"."'."Ef —Product Information
Model Type: DCS-100
B Backup
IP Camera License Number: 32
Metwiork Service

.E'.I'JI:ILIt Maiﬂ':DﬂED'E Device Pack Version: 1.44

FirstAdapter MAC: 00-24-Te-02-20-f3
Second Adapter MAC:

Build 3.5.7 0
20. How do | get the Windows system log and Oty EEm]
application log? gy = -
. yel o X ¥ -
- ;n
System log §d ® L B U U B
Step 1: Go to [Desktop] -> right click on . T W e ™™
[My Computer] -> [Manage] ( » B § 8 9 8
Step 2: In [Computer Management] -> go to e S
[System Tools] -> [Event Viewer] -> [System] = j J e
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Step 3: Right click on [System]->[Save Log File As...]

Step 4: Type "system" as file name and save as .evt format
Please name the file as "system" so we know that it is a system

log file

e o i o e

5

H
|

] Fioai
L L1ams.
[ ] L
(e [EL TR
LR iy
\avziz0e L]
[ETE e

Glwgery | Gweed | s
e -
LT -
oo .
s L
o8 -
o e
s -
. 1 [
e - =
s - s
e 1 -
o m =
e = =
oo = =
Lol - -
tar -
tors. 1 s
e - =
1 -
e - e
e i L]
- L] L
e -—
e I W
S -
e - L
M -
L] L

W

W

£

i

L

=

-

-

=

.

SRRRRRREREE

HiHilii]!fllii]ﬂli!illli[!lHilli]!ﬁ!

My Drocusments

My Comgputes

My Network

Ay use

My Prctures

)My Received Files

File name tyshem

Sevessbpe  Event Logl" evi

N

tm,

D-Link D-ViewCam User Manual

153



Section 4 - FAQs

Application log = G e e e fap

Step 1: Go to [Desktop]-> right click on [My Computer]-> P=-0 3 Prepra BN H

[Manage] r Pe & @ L B U U ;“-
Step 2: In [Computer Management]-> go to [System AF 4N A . N g amns
Tools]->[Event Viewer]->[Application] = 'H;'- = !-1 &) & &)

Step 3: Right click on [Application]->[Save Log File As...]

i

R T E e f e R TR A F I Y

PENN i: aiiill

FEE*I" 4" "t

adi

ST R B FE R R R
PHETR TRy

empdiig®
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Step 4: Type "application" as file name and save file with .evt

format Savein | ) My Documents v OF M
Plea_se name th_e file as "application" so we know that it is a o
application log file _.3) Smy Pctures
My Flecent My Received Files
Documents
Dresklop
L/
My Drocuments
My Compuater
. Fée pame spstem " E
MyNetwok  Sevessbpe | EventLoglevi) v Cancel |
21. How many user accounts can | create? : ' : B
CETETETTE T &
allr- - T P e > q __-
You can create an unlimited number of user accounts. 0 comwrwm * D
& X 2 » L0 2 & v &
22. How do | setup local area network or LAN? » P & D @Ez’“ B & L %
D-ViewCam supports both LAN and WAN. If your surveillance L ,_‘" _:" ,j_“,_ __“ ! e 8 ,;{: »
system does not need to have internet access, you can setup a .; R "i p Pl s g
private network or LAN to establish networking between A i ?,“ i
Mainconsole and other network devices such as IP camera. I o

Setup with static IP
Step 1: Go to [Control Panel]->[Network Connections]
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Step 2: Right click on [Local Area Connection]->[Properties] _

{}M N + e e > W)y
L w n'ﬁ
BT o e = Cmvm b Prawe F o e daiir
[ S——
» e e |
R i il Sl bl vt
[P —— Bl & e igmn

|
|

Ly g el o

it et s
G e S g

i

- Local Area Connection i"rl:l;u,'rlw:;

Step 3: Select [Internet Protocol(TCP/IP)]->[Properties] § —yr o

Connect using:

H9 Feakek RTLEBSCIPYS111CP) PO @

v 8 Chent for Microsoft Networks
¥ 2B File and Printer Shanng for Microsoft Metworks

Transmission Control Protocol/intemet Protocol The default
wade area netwaork. protocol that provides commurication
across diverse interconnected networks.

[7] Show icon in notification area when connected
[#] Notity me when this connection has limited of no connectivity

[ ok || cCance |
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Step 4: Select [Use the following IP address:] and fill the fields as shown in

the picture

[192.168.1.1] and [192.168.1.254] is normally occupied by the router or other

network devices, so please try to avoid using these |IP addresses.

Please note that you will only be able to access IP address between the same
subnet address, such as [192.168.1.1 to 192.168.1.254]

Setup with dynamic IP

We strongly discourage the assigning dynamic IP address to IP cameras which
is based on DHCP. The IP address of each IP cameras is temporary so
whenever the address is reassigned, the camera will lose connection
permanently to your D-ViewCam server unless you manually rematch the
camera's new IP address to D-ViewCam server.

Internet Protocol (TCP/IP) Properties

General
‘You can get IP settings assigned automabcally if your network supports

this capabdity Othensmse, pou read 1o ask pour netwark sdmrestrator for
the appropnate IP settings

() Obtan an IP addiess sutomatically
(®) Uge the following IP addvess
|P address 192 188, 1 . 10

Subnet mask
Default gateway

25.295.25%5. 0

(#) Use the lolowang DNS server addresses
Prefenred DNS server

Alternate DNS server

23. How should | do when popping-up UAC message?

|

When using Windows Vista, the system will pop-up the following
message to stop your D-ViewCam. {

Follow the following steps to turning off UAC.

:] MainConscle is going to disable UAC function.

oK
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1.) Go to Vista's [Control Panel]

2.) Click on [User Accounts]

Fitrsne:

Intarreet Enpiors
Dt

i ‘el ome Cente

!i ‘mindgeg Migbet; Cerier
‘ﬁ wnidows Mettng Spe.e
h ‘i Phaoti Daller

u ‘wwriowd Nigdia Playet

.m ‘wiridtd | el Maanenon Downiosd

CAISLIFTICR T8 IEEE BI0E B0 CTIDRSy Of ROl COMIae S o)
remeve progema md Wl up nebwork (onnmechon aned ues #<n g

Systerm and Wamtenance User Accounts
DT Tt st Ao, W ke or rerreve user arccunn
Bech up mour rompute

hange user BCCount HETENgE and

Secuirily h | el
hch b U] E

DIPGUEE § W LRy L e R i R
T
8 progrem Puragh Sntees i e A
duyunt preer reakhor

Clock, Language, end Regeon
Change veybosrt or othey ingJt
methad

Merwok and Intemet
e e Flai B ek
S g il L

" harge Buper. A gaege
Hardware ard Sound

£ BN (Priind il iy

Faze nt Aavesc
Lt Wmome uggeet watmgn
Cpbrnine i deley

Ernagrams wdditional Optians

Unahilalla progem

hange Aertup progrer
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3.) Click on [User Accounts]

Ml L'ser Accounts
g B picmes P Skl o0 rerveve il B0 Owy

Chis gy i Bl

. Windows CardSpace

L T o g s g

4.) Click on [Turn User Account Control on or off]

Make changes o your user account

T resbna pangasrd b o soceeed
Chamge yoit pucture
[ T

W Cmamgr o mooant tyme

W Tum L Scosuet Conirod oe or off
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5.) Click to deselect the [Turn User Account Control on or
off] box to turn off UAC

= Uyer Accounts + Tum User dcosunt Control On o OF

Turn on User Account Cantrod [UAC) to make your computer more secure

ey Accewnt Corivnl [UAC) (01 haip prevers snauthonzed changin bo your icmguder e scomemend tht
LA farcal 5 be bdp protact s ol

o
| \h-lUll.'lhl::uﬂl(Mr:i-l.-\-t-li-hﬂumhwumhlrI

6.) Click on [OK] and restart Windows to complete the new
setting

24. The camera

D-ViewCam supports both LAN and WAN. If your surveillance system does not need to have internet access, you can setup
a private network or LAN to establish networking between Mainconsole and other network devices such as IP camera.
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Open Source Software Notification

D-ViewCam 3.x product makes use of the following software licensed under LGPL (Lesser General Public License).
You can download the copies of the LGPL licensed software from the official web site listed as the following.

1.1 LIVE555 Streaming Media (www.live555.com/liveMedia/, GPL v2)
© 1991, 1999 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone
is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

1.2 ffmpeg v51.46.0 (www.ffmpeg.org, GPL v2)
© 1991, 1999 Free Software Foundation, Inc. 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone
is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

1.3 FAAC v20020104 (sourceforge.net/projects/faac, GPL v2)
© 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA Everyone is
permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the
copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public
License (also called “this License”). Each licensee is addressed as “you”.

A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application
programs (which use some of those functions and data) to form executables.

The “Library”, below, refers to any such software library or work which has been distributed under these terms. A
“‘work based on the Library” means either the Library or any derivative work under copyright law: that is to say, a work
containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into
another language. (Hereinafter, translation is included without limitation in the term “modification”.)
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“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete
source code means all the source code for all modules it contains, plus any associated interface definition files, plus
the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running a program using the Library is not restricted, and output from such a program is covered only if its
contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether
that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library’s complete source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer
of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a
copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library,
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet
all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices  stating that you changed the files and the date
of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this
License.
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d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program
that uses the facility, other than as an argument passed when the facility is invoked, then you must make a
good faith effort to ensure that, in the event an application does not supply such function or table, the facility still
operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of
the application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function
must be optional: if the application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Library, and can be reasonably considered independent and separate works in themselves, then this License,
and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the
same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the
terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every
part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the
Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy
of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary
GNU General Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary
GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any
other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License
applies to all subsequent copies and derivative works made from that copy.
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This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding
machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent
access to copy the source code from the same place satisfies the requirement to distribute the source code, even
though third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being
compiled or linked with it, is called a “work that uses the Library”. Such a work, in isolation, is not a derivative work
of the Library, and therefore falls outside the scope of this License.

However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library
(because it contains portions of the Library), rather than a “work that uses the library”. The executable is therefore
covered by this License. Section 6 states terms for distribution of such executables.

When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the
work may be a derivative work of the Library even though the source code is not. Whether this is true is especially
significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true
is not precisely defined by law.

If such an obiject file uses only numerical parameters, data structure layouts and accessors, and small macros and
small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether
it is legally a derivative work. (Executables containing this object code plus portions of the Library will still fall under
Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms
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of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly
with the Library itself.

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library
to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided
that the terms permit modification of the work for the customer’s own use and reverse engineering for debugging such
modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use
are covered by this License. You must supply a copy of this License. If the work during execution displays copyright
notices, you must include the copyright notice for the Library among them, as well as a reference directing the user
to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including
whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the
work is an executable linked with the Library, with the complete machine-readable “work that uses the Library”,
as object code and/or source code, so that the user can modify the Library and then relink to produce a modified
executable containing the modified Library. (It is understood that the user who changes the contents of definitions
files in the Library will not necessarily be able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at
run time a copy of the library already present on the user’s computer system, rather than copying library functions
into the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as
long as the modified version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified
in Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to
copy the above specified materials from the same place.
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e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the “work that uses the Library” must include any data and utility programs
needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need
not include anything that is normally distributed (in either source or binary form) with the major components (compiler,
kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot use both them and the Library together
in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with
other library facilities not covered by this License, and distribute such a combined library, provided that the separate
distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that
you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other
library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and
explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under
this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights, from
you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission
to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept
this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your
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acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library
or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives
a license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and
conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted herein. You
are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited
to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution
of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system which is implemented by public license practices. Many people have made generous contributions to the wide
range of software distributed through that system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted

interfaces, the original copyright holder who places the Library under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus
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excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which
applies to it and “any later version”, you have the option of following the terms and conditions either of that version
or of any later version published by the Free Software Foundation. If the Library does not specify a license version
number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible
with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the
two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse
of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY,
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY “AS IS” WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISKAS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS
PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL
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OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED
BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

2. Expat XML parser v2.0.1 (expat.sourceforge.net)
© 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
© 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

3. OpenSSL v0.9.8.g (www.openssl.org)

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the original
SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are BSD-style Open
Source licenses.
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© 1998-2007 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.
openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote products derived
from this software without prior written permission. For written permission, please contact penssl-core @ openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in their names
without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT AS IS” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
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OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

4. Crypto++ v5.5.2 (www.cryptopp.com)

© 1995-2006 by Wei Dai. All rights reserved.

This copyright applies only to this software distribution package as a compilation, and does not imply a copyright on
any particular file in the package.

The following files are copyrighted by their respective original authors, and their use is subject to additional licenses
included in these files.

mars.cpp - Copyright 1998 Brian Gladman.
All other files in this compilation are placed in the public domain by Wei Dai and other contributors.
| would like to thank the following authors for placing their works into the public domain:

Joan Daemen - 3way.cpp

Leonard Janke - cast.cpp, seal.cpp

Steve Reid - cast.cpp

Phil Karn - des.cpp

Michael Paul Johnson - diamond.cpp

Andrew M. Kuchling - md2.cpp, md4.cpp

Colin Plumb - md5.cpp, md5mac.cpp

Seal Woods - rc6.cpp

Chris Morgan - rijndael.cpp

Paulo Baretto - rijndael.cpp, skipjack.cpp, square.cpp
Richard De Moliner - safer.cpp

Matthew Skala - twofish.cpp

Kevin Springle - camellia.cpp, shacal2.cpp, ttmac.cpp, whripool.cpp, ripemd.cpp
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Permission to use, copy, modify, and distribute this compilation for any purpose, including commercial applications,
is hereby granted without fee, subject to the following restrictions:

1. Any copy or modification of this compilation in any form, except in object code form as part of an application software,
must include the above copyright notice and this license.

2. Users of this software agree that any modification or extension they provide to Wei Dai will be considered public
domain and not copyrighted unless it includes an explicit copyright notice.

3. Wei Dai makes no warranty or representation that the operation of the software in this compilation will be error-
free, and Wei Dai is under no obligation to provide any services, by way of maintenance, update, or otherwise. THE
SOFTWARE AND ANY DOCUMENTATION ARE PROVIDED “AS IS” WITHOUT EXPRESS OR IMPLIED WARRANTY
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. INNO EVENT WILL WEI DAIOR ANY OTHER CONTRIBUTOR BE LIABLE FOR DIRECT,
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

4. Users will not use Wei Dai or any other contributor’'s name in any publicity or advertising, without prior written
consent in each case.

5. Export of this software from the United States may require a specific license from the United States Government.
It is the responsibility of any person or organization contemplating export to obtain such a license before exporting.

6. Certain parts of this software may be protected by patents. It is the users’ responsibility to obtain the appropriate
licenses before using those parts.

If this compilation is used in object code form in an application software, acknowledgement of the author is not required
but would be appreciated. The contribution of any useful modifications or extensions to Wei Dai is not required but
would also be appreciated.
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